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1 Introduction, Standards and Specifications

1 Introduction, Standards and Specifications

1.1 Introduction
Thank you for purchasing the permanent Sound Insulation Option or the annual Sound Insu-
lation Reporter 365 license for the XL2 Acoustic Analyzer and XL3 Acoustic Analyzer. This
enables the import of the measurement data into the Sound Insulation Reporter PC-soft-
ware. The Sound Insulation Reporter is a PC-based software application that provides all the
reports for airborne, impact and facade sound insulation measurements.

Designed for acoustic consultants, this comprehensive tool uses data gathered by the XL2
Acoustic Analyzer or XL3 Acoustic Analyzer and quickly returns graphical analysis of all
measurement positions. Analyzing the measurement data and producing reports is straight-
forward using the Sound Insulation Reporter software. Simply drag & drop the measurement
data from your XL2 Acoustic Analyzer or XL3 Acoustic Analyzer into the software and print
the report.
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1 Introduction, Standards and Specifications

Additionally, the software offers remote measurements, allowing direct control of one or mul-
tiple XL2 or XL3 Acoustic Analyzers connected via USB or wireless. This allows for parallel
measurements of sending and receiving room onsite, offering significant time saving.

The following tutorial provides a step-by-step instruction. The appendix includes more
details on a typical onsite measurement procedure.

1.1.1 My First Steps
Sound Insulation is the measurement of the influence that a partition (usually a wall or ceil-
ing) has on sound; in other words, how efficiently a partition insulates the sound between
rooms. To evaluate this, a reference sound signal is generated in the sending room, and the
noise spectrum is measured in both the sending and the receiving room. Additionally, a room
correction of the receiving room is applied based on the measurement of the reverberation
time.

The Sound Insulation Reporter software offers the following measurement modes:

With XL3 Acoustic Analyzer:
Measurement using XL3 Acoustic Analyzer Sound Insulation Option:

The measurements are performed with the XL3 Acoustic Analyzer Sound
Insulation Option. ISO 16283, Document E, and ASTM standards are imple-
mented, allowing results to be displayed directly on the XL3 Acoustic Ana-
lyzer. All data is later on imported into the Sound Insulation Reporter
software.

Manual Measurement using XL3 Acoustic Analyzer :
The measurements are performed manually with the XL3 Acoustic Analyzer.
All data is later on imported into the Sound Insulation Reporter software.

With XL2 Acoustic Analyzer:
Manual Measurement using XL2 Acoustic Analyzer:

The measurements are performed manually with the XL2 Acoustic Analyzer.
All data is later on imported into the Sound Insulation Reporter software.

Automated Measurement (remote controlled):
One or more Acoustic Analyzers may be controlled directly by the software con-
nected via USB or wireless. This offers parallel measurements of sending and
receiving room onsite.

1.1.2 Software Installation

Install the Sound Insulation Reporter software on your PC.

1.1.3 XL3 Acoustic Analyzer Requirements

Sound Insulation Bundle that includes:

Sound Insulation Option for XL3 Acoustic Analyzer (Optional);

Sound Insulation Reporter Software License.
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1 Introduction, Standards and Specifications

Install the Sound Insulation Option on the XL3 Acoustic Analyzer and request the
online activation of the annual Sound Insulation Reporter 365. This enables the data
import into the Sound Insulation Reporter software;
Install the XL3 Acoustic Analyzer firmware V 1.46, or a more recent version.

1.1.4 XL2 Acoustic Analyzer Requirements

Installed optional Extended Acoustic Pack to measure the reverberation time in 1/3
octave band resolution.

Installed Remote Measurement Option to measure sending and receiving room sim-
ultaneously with two connected instruments controlled directly within the Sound Insu-
lation Reporter software.

Install the permanent Sound Insulation Option on the XL2 Acoustic Analyzer and
request the online activation of the annual Sound Insulation Reporter 365. This
enables the data import into the Sound Insulation Reporter software;
Install the latest XL2 Acoustic Analyzer firmware V4.84. For XL2-TA Sound Level
Meters use the latest certified firmware V4.71 - Austria and France requires V4.21.

1.2 Standards and Specifications
The Sound Insulation Reporter is a PC-based software application that provides all the
standard reports for Airborne, Impact and Facade sound insulation measurements.
Designed for acoustic consultants, this comprehensive tool uses data gathered by the
Acoustic Analyzer, and quickly returns graphical analysis for all measurement positions in
accordance with the following standards and specifications:
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1 Introduction, Standards and Specifications

Airborne Sound Insulation

Standards

ASTM E336-20

ASTM E413

DIN 4109

England/Wales: Approved Document E(2003)

BB93

GB/T 19889.4 - 2005

ISO 10140:2021

ISO 140-4:1998

ISO 717-1:1996

ISO 16283-1:2014 incl. Rooms < 25m3

ISO 717-1:2021

ISO 12999-1:2014

NEN 5077:2019

SIA181:2006

SIA181:2020

Results

ASTM:

NR, NIC

NNR, NNIC

ATL,ASTC

ISO:

Dw

Dn,w

DnT,w

R'w

Spectrum adaption terms C, Ctr

10



1 Introduction, Standards and Specifications

Impact Sound Insulation

Standards

ASTM E1007

ASTM E989

DIN 4109

England/Wales: Approved Document E(2003)

BB93

GB/T 19889.7 - 2005

ISO 10140:2021

ISO 140-7:1998

ISO 717-2:1996

ISO 16283-2:2018 incl. Rooms < 25m3

ISO 717-2:2020

ISO 12999-1:2014

NEN 5077:2019

SIA181:2006

SIA181:2020

Results

ASTM:

ISPL,ISR

RTNISPL,AIIC

ANISPL,NISR

ISO:

L'n,w
L'nT,w
Spectrum adaption terms CI
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Facade Sound Insulation

Standards

ASTM E966

ASTM E1332

DIN 4109

GB/T 19889.5 - 2006

ISO 140-5:1998

ISO 717-1:1996

ISO 16283-3:2016 incl. Rooms < 25m3

ISO 717-1:2021

ISO 12999-1:2014

NEN 5077:2019

SIA181:2006

SIA181:2020

Results

ASTM:

OINR, OINIC

AOITL, AOITC

ISO:

Dw

R'45°,w

Dxx,2m,w

Dxx,2m,n,w

Dxx,2m,nT,w

Spectrum adaption terms C, Ctr

Specifications

Sound Sources

Airborne Sound Insulation:

Speaker

Impact Sound Insulation:

Tapping Machine

Rubber Ball

Facade Sound Insulation:

Speaker

Road Traffic

Railway Traffic

Aircraft Traffic

12



1 Introduction, Standards and Specifications

Specifications
Measurement
Uncertainty

In situ standard deviation in accordance with ISO 12999-1 for the stand-
ards BB93, DIN 4109, ISO 16283, ISO 10140, NEN 5077 and SIA 181

Reporting

PDF via PDF-printer

XPS

Copy/paste data into User Reports

Languages
English, German and Chinese

Report: Czech, Dutch, French, Italian, Korean, Swedish
Operating Sys-
tem

Windows Vista, 7, 8, x and 10

Licensing

Install Sound Insulation Option into XL3 Acoustic Analyzer or XL2
Acoustic Analyzer or activate Sound Insulation Reporter 365
online at my.nti-audio.com; this enables the import of meas-
urement data into the Sound Insulation Reporter software

Sound Insulation Reporter can be installed on multiple computers

XL3 Acoustic
Analyzer
Requirements

Sound Insulation Bundle that includes:

Sound Insulation Option (permanent)

Optional but not mandatory

Sound Insulation Reporter Software License (permanent)

XL2 Acoustic
Analyzer
Requirements

Optional but not mandatory Installed optional Extended Acoustic
Pack to measure the reverberation time in 1/3 octave band res-
olution.

Installed Remote Measurement Option to measure sending and
receiving room simultaneously with two connected instruments
controlled directly within the Sound Insulation Reporter software.

Order Inform-
ation

XL3 Acoustic Analyzer:

Sound Insulation Bundle
NTi Audio # 600 000 742

XL2 Acoustic Analyzer:

Sound Insulation Option
NTi Audio # 600 000 432

Sound Insulation Reporter 365 (annual subscription service)
NTi Audio # 600 000 433

All information is subject to change without notice.
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2 Measurement with XL3 Acoustic Analyzer

2 Measurement with XL3 Acoustic Analyzer

2.1 Measurement Configurations
Sound insulation measurements may be performed in various configurations.

2.1.1 Measurement of Sending- and Receiving Room
The Dodecahedron Speaker Set provides the test signal at continuous sound pressure level

for long time; e.g. 1 hour. This supports precise sound insulation readings at measuring the

sending and receiving room sequentially. This is the recommended configuration:

Measurement with Sound Insulation Option
Measurements are performed by one person. All measurement data is loaded into Sound
Insulation Reporter software after completed measurement

1x Dodecahedron Speaker Set;

1x XL3 Acoustic Analyzer;

1x M2230 Measurement Microphone;

1x Sound Insulation Option;

1x ASD Cable 5m (alternatively 10m or 20m);

1x Mains Power Adapter XL3 Acoustic Analyzer;

1x Exel System Case;

1x Windows Computer, Laptop or Tablet (to analyze data in Sound Insulation
Reporter after completed measurements).

Manual Sequential Measurement
Measurements are performed by one person. All measurement data is loaded into Sound
Insulation Reporter software after completed measurement

1x Dodecahedron Speaker Set;

1x XL3 Acoustic Analyzer;

For Reverberation Time measurements using a 1/3 octave filter, the Sound Insu-
lation Option or the Reverberation Time Option is required. Without these
options, you can only perform octave measurements, which limits the standards
available in the Sound Insulation Reporter.

1x M2230 Measurement Microphone;

1x ASD Cable 5m (alternatively 10m or 20m);

1x Mains Power Adapter XL3 Acoustic Analyzer;

1x Exel System Case;

1x Windows Computer, Laptop or Tablet (to analyze data in Sound Insulation
Reporter after completed measurements).
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2 Measurement with XL3 Acoustic Analyzer

2.1.2 Simultaneous Measurement in Sending- and Receiving Room
The simultaneous measurement configuration reduces the measurement uncertainty; the

noise level is measured in both rooms at the same time. This is the recommended con-
figuration:

Manual Simultaneous Measurement
Measurements are performed by two persons - one in each room. All measurement data is
loaded into Sound Insulation Reporter software after completed measurement.

1x Dodecahedron Speaker Set;

2x XL3 Acoustic Analyzer;

For Reverberation Time measurements using a 1/3 octave filter, the Sound Insu-
lation Option or the Reverberation Time Option is required. Without these
options, you can only perform octave measurements, which limits the standards
available in the Sound Insulation Reporter.

2x M2230 Measurement Microphone;

2x ASD Cable 5m (alternatively 10m or 20m);

2x Mains Power Adapter XL3 Acoustic Analyzer;

2x Exel System Case;

1x Windows Computer, Laptop or Tablet (to analyze data in Sound Insulation
Reporter after completed measurements).

2.2 Measurement with XL3 Acoustic Analyzer Sound Insulation Option
Effective sound insulation is a crucial factor in building design, and the XL3 Acoustic Ana-
lyzer provides extensive support for measuring various procedures in the application of build-
ing acoustics. This includes:

Airborne sound insulation;

Impact sound insulation;

Facade sound insulation.

Users can access the measurement function by tapping the menu icon in the upper left
corner and selecting “Sound Insulation”. The XL3 Acoustic Analyzer allows for continuous
recording and display of the individual measurements needed to assess the desired sound
attenuation.
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2 Measurement with XL3 Acoustic Analyzer

2.2.1 Start partition

Tap the button to start.

Wear appropriate hearing protection
before activating the sound source!

Standard:

ISO 16283;

Document E;

ASTM.

Type:

Airborne;

Impact;

Facade.

Source Positions:

1 to 4.

2.2.2 Page selection by means of page key

Press the page key to toggle between the numerical and spectral display. This change
is possible without restriction even during a running measurement.

2.2.3 Page selection via the display
You can also select the desired display with a swiping motion, or by tapping the cor-
responding icons.

Shows the Sound Insulation measured values and displays the spectral res-
ults
In this menu the sound level meter is configured and the layout of the
numerical display can be adjusted. These settings are detailed under Set-
tings display.
The menu Select measurement display shows the measurements required
for each of the available standards and for each partition. You can com-
plete these measurements in any order, allowing you to import data from
previous measurements. This feature helps to save time and optimize a
series of measurements.
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2 Measurement with XL3 Acoustic Analyzer

2.2.4 Spectral display

If you tap on, for example, , the page dis-
playing the current sound level spectrum in
third octave band resolution will appear.

The display allows to navigate through the
single band values of Live and average res-

ults using the cursor, arrow keys and

;

Moreover, at any time, you can tap the
button at the bottom right to view

the measured results up to that point or their
average value “AV”;

Live data can be switched on and off
manually, but no longer interferes when it is
switched off.

To start the measurement, tap the button

.

The average of the active position is shown in
red.

When displaying the sending room level,
the maximum difference between neigh-
boring bands of the sound soruce are
checked acccording the the applied
standard. Exceedings are marked with
an .
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2 Measurement with XL3 Acoustic Analyzer

When a position is disabled, the result is
updated immediately.

Disabled measurements are indicated
as grey in the "Select Measurement"

screen .

The background noise level B2 is shown in the L2
results screen to allow identifying potential conflicts.

If an L2 band is less than 6 dB or 10 dB
above the corresponding B2 band, it is
labelled or respectively in the
SIR display.

2.2.5 Settings display
To select the desired page, tap the corresponding button at the top right of each page.

18



2 Measurement with XL3 Acoustic Analyzer

On the "Settings" page you can make the following
settings:

SLMmeasurement duration: 6, 15, 30 or 60
seconds;

Reverb. Time: T20 or T30;

Min. Trigger Level: 80 dB.

Select the appropriate settings before
starting measurements!

2.2.6 Select measurement display

At the "Select measurement" page, you may
choose the next measurement to be conducted, as
well as view the results.

Transmitting room: L1-x = position of noise
source in the transmitting room (number of
available positions depends on the afore-
mentioned Setting off);

Receiving Room:

L2-x = measuring position in the receiv-
ing room (number of available positions
depends on the above-mentioned setting
off);

B2 = Background sound level in the
receiving room;

T2 = Reverberation time in the receiving
room.

Results: D, Dn, DnT or R';
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2 Measurement with XL3 Acoustic Analyzer

NOTE: During a measurement series, you can
check the number of individual measurements taken
in the transmitting or receiving room at different
sound source positions on the "Select meas-
urement" page.
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2 Measurement with XL3 Acoustic Analyzer

It is possible to exclude individual measurements from
the averaging process. This can be done either dir-
ectly after a faulty measurement or in post-processing.

Active and excluded measurements are

clearly indicated in the overview. This
ensures that an overview is always main-
tained.

After tapping on the Result, you can provide the dimen-
sions of the room (e.g., common area (m²), source
room (m³), and receiving room (m³)).

2.2.7 Perform sound insulation measurement
The measurement process involves placing the noise source in sending room and meas-
uring parameters in both the sending and receiving rooms. For this purpose, the XL3 Acous-
tic Analyzer shows on the display, or the sound level spectrum in the sending or receiving
room, i.e.:

L1: Level in the sending room;

L2: Level in the receiving room;
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2 Measurement with XL3 Acoustic Analyzer

B2: Background level in the receiving room;

T2: Reverberation time in the reception room.

2.2.7.1 Background Noise Measurement in the Receiving Room

All measurements can be carried out in the desired order without influencing the final result;
however, it is recommended to start with the background level in the receiving room. This ini-
tial measurement helps the user understand the appropriate sound level at which the sound
source should be set to ensure a good signal-to-noise ratio.

To measure the background sound level in the receiving room (i.e., with the noise
source turned off). To do this, select on the "Select measurement" page and press
the button.

2.2.7.2 Sound Level Measurement in the Sending Room

Switch on the sound source (e.g. dodecahedron loudspeaker DS3) and move to the desired
measurement position. Then, press the key to initiate the first measurement and wait
until it is completed. Move to the next measurement position and press the key again
to start the second (or third, etc.) sound level measurement in the receiving room.

Once you have taken enough individual measurements for , press the key.
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2 Measurement with XL3 Acoustic Analyzer

2.2.7.3 Sound Level Measurement in the Receiving Room

Proceed to the L2 receiving room and choose located on the "Select measurement"
page. Activate the sound source (which is still placed at position #1 in the transmitting room)
and press the button to initiate the initial sound level measurement in the receiving
room.

Proceed with conducting the remaining measurements in the receiving room for the data set
and then press the button.

Select on the "Select measurement" page and position the noise source in the trans-
mitter room at position #2.

Repeat the aforementioned measurements in both the transmit and receive rooms for noise
source position #2. Repeat this process until all L1-x and L2-x measurements for different
noise source positions in the sending room are completed.
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2 Measurement with XL3 Acoustic Analyzer

2.2.7.4 Reverberation Time Measurement in the Receiving Room

Now position the dodecahedron loudspeaker in the receiving room to determine the rever-
beration time T2. Choose on the "Select measurement" page. Press the button
to commence the reverberation time measurement and toggle the speaker On and Off mul-
tiple times. Then press the button.

Conclude the measurement series by first pressing the button and then tapping

.

You can now review the measurement results D, Dn, DnT, or R' individually by pressing the
corresponding button under "Results".
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2 Measurement with XL3 Acoustic Analyzer

2.2.8 Data Import
The XL3 Acoustic Analyzer measurement data may be imported into the software by drag
and drop. The minimum requirement for a successful data import is an XL3 with firmware
V1.46 or higher and activated Sound Insulation Option. The Sound Insulation Reporter soft-
ware verifies the available option online during the data import. Any recorded data with A- or
C-weighting is automatically corrected to Z-weighting (=no weighting).

Start the Sound Insulation Reporter software;

Click on File -> New;

Select your requested Standard;

Select Airborne, Impact or Facade Sound Insulation;

Select the number of Speaker positions used;

Select Unit;

Define the required Results;

Select the preferred Rating Format. Choose either Dw(C;Ctr) = 41 (-1;-3) dB or Dw =
40.5 dB +/- 0.9 dB;

Confirm withOK.
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2 Measurement with XL3 Acoustic Analyzer

The measurement view with the message "Drop measurement files or folder here”
is displayed.

Kindly ensure, prior the data import, that the partition folder contains all required meas-
urement data (*.txt) and *,xI3si system files of each recorded measurement.

Site View:

Drag and drop the complete partition folder from the XL3 Acoustic Analyzer
memory card into the field Drop measurement files or folder here. The par-
tition folder should include the noise spectrum data, the reverberation time data
and the *,xI3si system files.
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2 Measurement with XL3 Acoustic Analyzer

New Partition:

Drag and drop the supported files directly into the Drop measurement files or
folder here field.

The supported files for drag and drop in New Partition are .xl3 and
.zip;

You can also click on Import in the main window and select the partition folder.
Confirm the selection;

Alternatively, click on File -> Import and select the folder or single/multiple data
files. Confirm the selection.

The measurement data is imported.

All measurement data with mapping information in the file name are assigned automatically
by the software, e.g, "L1-1_SLM_001_RTA_3rd_Report.txt” is assigned to L1-1 (=speaker
position 1 in the sending room). Alternatively, the mapping may be assigned manually to
sending room or receiving room and the individual speaker positions:
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2 Measurement with XL3 Acoustic Analyzer

Select the measurement with the mouse;

Click on the right mouse button;

Select Assign To;

Assign the measurement;

Verify the measurement data and delete any false readings from theMeasurements
list on the right.

2.2.9 Measurement Report

Select View -> Calculations in the menu;

Verify the individual averaged results.

Select the View -> Results,

The sound insulation data and chart are displayed.
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2.3 Manual Measurement with XL3 Acoustic Analyzer

2.3.1 Preparing your XL3 Acoustic Analyzer for Manual Measurements
Access System Settings: Tap the
Menu Icon and go to System Set-

tings ;

Set Save Option: In General ,
set "Save" to "manually";

Create or Select Folder: Tap
"Folder" to create a new folder or
choose an existing one.

To create a new folder, tap the
option for creating.

2.3.2 Perform Noise Spectrum Measurements

Choose Sound Level Meter: To activate the sound level meter mode, tap the Menu
Icon in the upper left corner and then tap "Sound Level Meter";

Check Logging Settings: In the Settings menu , go to Report & Logging and
make sure the Logging Interval is set to "off";

Select Spectral Display: Choose the Spectral Display option.
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Set Frequency Weighting:Make sure "Z" frequency weighting is selected.

Set Timer: Choose the Timer Mode option as "Single" and set the duration you want,
like 30 seconds.

To access Timer mode, before starting a measurement, you must tap the
“READY” icon.

Start the Measurement;

Save the Measurement: After the
measurement, save the file by tap-

ping on .

You can use names like L1-1,
L1-2, L2-1, L2-2, B2.
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2.3.3 Perform Reverberation Time Measurements

Choose Reverberation Time: To activate the Reverberation Time mode, tap the
Menu Icon in the upper left corner, then select "Reverberation Time".

For Reverberation Time measurements using a 1/3 octave filter, the Sound
Insulation Option or the Reverberation Time Option is required. Without
these options, you can only perform octave measurements, which limits the
standards available in the Sound Insulation Reporter.

Start the Measurement;
Stop the Measurement;

Save the Measurement: After the
measurement, save the file by tap-

ping on .

Suggestion: Use the name T2.

2.3.4 Data Import
The XL2 Acoustic Analyzer measurement data may be imported into the software by drag
and drop. The minimum requirement for a successful data import is an XL2 with firmware
V4.03 or higher and activated Sound Insulation Option. Instruments using an older firmware
may benefit from the online activation of the option without installation on the device. The
Sound Insulation Reporter software verifies the available option online during the data
import. Any recorded data with A- or C-weighting is automatically corrected to Z-weighting
(=no weighting).

Start the Sound Insulation Reporter software;

Click on File -> New;
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Select your requested Standard;

Select Airborne, Impact or Facade Sound Insulation;

Select the number of Speaker positions used;

Select Unit;

Define the required Results;

Select the preferred Rating Format. Choose either Dw(C;Ctr) = 41 (-1;-3) dB or Dw =
40.5 dB +/- 0.9 dB;

Confirm withOK.

32



2 Measurement with XL3 Acoustic Analyzer

The measurement view with the message "Drop measurement files or folder here”
is displayed.

Kindly ensure, prior the data import, that the partition folder contains all required meas-
urement data (*.txt) and *,xI2 system files of each recorded measurement.

Drag and drop the complete partition folder from the XL2 Acoustic Analyzer memory
card into the field Drop measurement files or folder here. The partition folder
should include the noise spectrum data, the reverberation time data and the *,xI2 sys-
tem files.

Sound Insulation Reporter offers further possibilities to import measurement data:

Select all *.xI2 files in the partition folder with all measurement data. Drag and drop the
data into the Drop measurement files or folder here field;

Click on Import in the main window and select the partition folder. Confirm the selec-
tion;

Click on File -> Import and select the folder, single or multiple data files. Confirm the
selection.
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The measurement data is imported.

All measurement data with mapping information in the file name are assigned automatically
by the software, e.g, "L1-1_SLM_001_RTA_3rd_Report.txt” is assigned to L1-1 (=speaker
position 1 in the sending room). Alternatively, the mapping may be assigned manually to
sending room or receiving room and the individual speaker positions:

Select the measurement with the mouse;

Click on the right mouse button;

Select Assign To;

Assign the measurement;

Verify the measurement data and delete any false readings from theMeasurements
list on the right.
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2.3.5 Measurement Report

Select View -> Calculations in the menu;

Verify the individual averaged results.

Select the View -> Results,

The sound insulation data and chart are displayed.
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Complete the header data with information about client, object, description, partition
area and room volumes;

Print the sound insulation report.

Congratulations, your report is completed!
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3 Manual Measurement with XL2 Acoustic Analyzer

3.1 Measurement Configurations
Sound insulation measurements may be performed in various configurations.

3.1.1 Sequential Measurement of Sending- and Receiving Room
The Dodecahedron Speaker Set provides the test signal at continuous sound pressure level
for long time; e.g. 1 hour. This supports precise sound insulation readings at measuring the
sending and receiving room sequentially. These are the recommended configurations:

Manual Sequential Measurement
Measurements are performed by one person. All measurement data is loaded into Sound
Insulation Reporter software after completed measurement with XL2 Acoustic Analyzer.

1x Dodecahedron Speaker Set;

1x XL2 Acoustic Analyzer;

1x M2230 Measurement Microphone;

1x Extended Acoustic Pack;

1x Sound Insulation Option;

1x ASD Cable 5m (alternatively 10m or 20m);

1x Mains Power Adapter XL2 Acoustic Analyzer;

1x Exel System Case;

1x Windows Computer, Laptop or Tablet (to analyze data in Sound Insulation
Reporter after completed measurements).

3.1.2 Simultaneous Measurement in Sending- and Receiving Room
The simultaneous measurement configuration reduces the measurement uncertainty; the
noise level is measured in both rooms at the same time. These are the recommended con-
figurations:
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Manual Simultaneous Measurement
Measurements are performed by two persons - one in each room. All measurement data is
loaded into Sound Insulation Reporter software after completed measurement.

1x Dodecahedron Speaker Set;

2x XL2 Acoustic Analyzer;

2x M2230 Measurement Microphone;

2x Extended Acoustic Pack;

2x Sound Insulation Option;

2x ASD Cable 5m (alternatively 10m or 20m);

2x Mains Power Adapter XL2 Acoustic Analyzer;

2x Exel System Case;

1x Windows Computer, Laptop or Tablet (to analyze data in Sound Insulation
Reporter after completed measurements).

3.2 Manual Measurement with XL2 Acoustic Analyzer

3.2.1 Mapping File for XL2 Acoustic Analyzer
The measurement task onsite is made up of a several separate measurements. The XL2
Acoustic Analyzer may assign each of these measurements with a dedicated mapping, e.g.
“L1-1” for the readings taken in the sending room with speaker position 1. This feature sup-
ports automated post-processing and reporting in the Sound Insulation Reporter software.

Load the text file “savenames.txt” with the user defined mapping, such as “L1-1”, “L1-
2”,..., into the root directory of the XL2 Acoustic Analyzer. The text file “savenames.txt”
may be generated by the Sound Insulation Reporter software:

Click on Settings;

Select the tabMapping;

Click Export,
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Load the txt-file “savenames.txt” with the various mappings onto the root directory of
the XL2 Acoustic Analyzer,

Next select “Autosave: Off” in the XL2 Acoustic Analyzer memory menu. This allows
you to store each individual measurement with the desired mapping. The XL2 Acous-
tic Analyzer then uses the same mapping for subsequent measurements by default.
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3.2.2 Set XL2 Acoustic Analyzer Memory Structure for Multiple Partitions
In applications with multiple partitions, it is recommended to use a separate memory folder
on the XL2 Acoustic Analyzer for each partition. All measurements belonging to a single par-
tition are then stored in the same folder on the XL2 Acoustic Analyzer memory card. Meas-
urements belonging to multiple partitions can be later copied into the individual partition
folders on the computer. Each partition will be an individual project later on in the Sound Insu-
lation Reporter software.

Connect the XL2 Acoustic Analyzer to the computer and select “Mass Storage”;

Open the folder “Projects”;

Generate new subfolders for each partition, e.g. Partition 1, Partition 2, PartitionRoom
1-2, ...
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3.2.3 Instrument Settings

A dedicated profile for Sound Insulation Testing is available for download here. This
includes all required instrument settings for successful measurements. Importing the
profile into your Sound Level Meter is described in the XL2-Manual; search for “Import
MyProfile from PC”;

Alternatively, you can configure the XL2 Acoustic Analyzer manually. Set the reporting
to Add Spectra: All. No specific settings for the broadband report levels are required
(Report Values) - these levels are not required for sound insulation testing.

3.2.4 Perform Noise Spectrum Measurements

Select the SLMeter measurement function on the XL2 Acoustic Analyzer;

Select the RTA screen and 1/3 octave resolution measurements;

Ensure the frequency weighting "Z" is selected (= no weighting);

Start the measurement (hint: best use the single timer setting);

Stop the measurement after 15 seconds;
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Open the memory menu and select “Save Test”;

The XL2 Acoustic Analyzer displays the Save Test pop-up; select “Sound-Insul” at the
right end of the first line;

Select the applicable mapping;

Confirm your selection with the enter key and save the measurement. The XL2 Acous-
tic Analyzer saves the measurement data with a file name such as “L1-1_SLM_003_
RTA_3rd_Report.txt”;

Continue with the further measurements "L1-2..., etc.” in the same manner.

3.2.5 Perform Reverberation Time Measurements

Select the RT60 measurement function on the XL2 Acoustic Analyzer;

Select 1/3 octave resolution (requires the optional Extended Acoustic Pack pre-
installed in the XL2 Acoustic Analyzer);

Start the measurement;

Stop the measurement;
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Open the memory menu and select “Save Test”;

The XL2 Acoustic Analyzer displays the Save Test pop-up; select “Sound-Insul” at the
right end of the first line;

Select the applicable mapping;

Confirm your selection with the enter key and save the measurement. The XL2 Acous-
tic Analyzer saves the measurement data with a file name such as “T2_RT60_000_
Report.txt”;

Continue with the further measurements in the same manner.

3.2.6 Data Import
The XL3 Acoustic Analyzer measurement data may be imported into the software by drag
and drop. The minimum requirement for a successful data import is an XL3 with firmware
V1.46 or higher and activated Sound Insulation Option. The Sound Insulation Reporter soft-
ware verifies the available option online during the data import. Any recorded data with A- or
C-weighting is automatically corrected to Z-weighting (=no weighting).

Start the Sound Insulation Reporter software;

Click on File -> New;
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Select your requested Standard;

Select Airborne, Impact or Facade Sound Insulation;

Select the number of Speaker positions used;

Select Unit;

Define the required Results;

Select the preferred Rating Format. Choose either Dw(C;Ctr) = 41 (-1;-3) dB or Dw =
40.5 dB +/- 0.9 dB;

Confirm withOK.
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The measurement view with the message "Drop measurement files or folder here”
is displayed.

Kindly ensure, prior the data import, that the partition folder contains all required meas-
urement data (*.txt) and *,xI2 system files of each recorded measurement.

Drag and drop the complete partition folder from the XL2 Acoustic Analyzer memory
card into the field Drop measurement files or folder here. The partition folder
should include the noise spectrum data, the reverberation time data and the *,xI2 sys-
tem files.

Sound Insulation Reporter offers further possibilities to import measurement data:

Select all *.xI2 files in the partition folder with all measurement data. Drag and drop the
data into the Drop measurement files or folder here field;

Click on Import in the main window and select the partition folder. Confirm the selec-
tion;

Click on File -> Import and select the folder, single or multiple data files. Confirm the
selection.
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The measurement data is imported.

All measurement data with mapping information in the file name are assigned automatically
by the software, e.g, "L1-1_SLM_001_RTA_3rd_Report.txt” is assigned to L1-1 (=speaker
position 1 in the sending room). Alternatively, the mapping may be assigned manually to
sending room or receiving room and the individual speaker positions:

Select the measurement with the mouse;

Click on the right mouse button;

Select Assign To;

Assign the measurement;

Verify the measurement data and delete any false readings from theMeasurements
list on the right.
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3.2.7 Measurement Report

Select View -> Calculations in the menu;

Verify the individual averaged results.

Select the View -> Results,

The sound insulation data and chart are displayed.
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Complete the header data with information about client, object, description, partition
area and room volumes;

Print the sound insulation report.

Congratulations, your report is completed!

3.3 Automated Measurement (remote controlled)
The Sound Insulation Reporter software facilitates remote sound insulation measurements
using compatible Acoustic Analyzers. Both the XL3 Acoustic Analyzer and XL2 Acoustic
Analyzer offer options for remote measurement, but they differ in their connectivity require-
ments.
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XL3 Acoustic Analyzer: can be connected to the sameWi-Fi network as the com-
puter running the Sound Insulation Reporter. This allows the software to automatically
detect the XL3 Acoustic Analyzer units, enabling users to initiate measurements
remotely. While wireless measurement is an option, it is not the only method available;
users can also connect via USB-C cable.

XL2 Acoustic Analyzer: in contrast, the XL2 Acoustic Analyzer analyzers require the
activation of the remote measurement option and must be connected via a USB cable
to perform remote measurements using the Sound Insulation Reporter.

For example, one XL3 Acoustic Analyzer can be positioned in the source room while another
XL3 Acoustic Analyzer is in the receiving room to measure airborne sound insulation. The
communication between the analyzers and the software is primarily wireless for XL3 Acous-
tic Analyzer units, providing flexibility in measurement setups.

3.3.1 Simultaneous Measurement in Sending and Receiving Room
The simultaneous measurement configuration reduces the measurement uncertainty; the
noise level is measured in both rooms at the same time. These are the recommended con-
figurations:

Automated Simultaneous Measurement
Configuration is remotely controlled by one person.

1x Dodecahedron Speaker Set;

2x Acoustic Analyzers (XL3 Acoustic Analyzer or XL2 Acoustic Analyzer);

2x M2230 Measurement Microphone;

With XL3 Acoustic Analyzer:

2x Sound Insulation Option.

With XL2 Acoustic Analyzer:

2x Extended Acoustic Pack;

2x Sound Insulation Option;

2x Remote Measurement Option;

2x ASD Cable 5m (alternatively 10m or 20m);

2x Mains Power Adapter (optional);

2x Exel System Case (optional);

1x Windows Computer, Laptop or Tablet (to start/stop measurements live in Sound
Insulation Reporter);

Using XL3 Acoustic Analyzer:

1x Wi-Fi Access Point (Hotspot).

Using XL2 Acoustic Analyzer:

1x Wi-Fi Access Point (generating Wi-Fi network, e.g. SILEX SX-ND-4350
WAN) or USB Device Server (using existing Wi-Fi network); available at your
preferred supplier.
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3.3.2 Sequential Measurement of Sending and Receiving Room
The Dodecahedron Speaker Set provides the test signal at continuous sound pressure level
for long time; e.g. 1 hour. This supports precise sound insulation readings at measuring the
sending and receiving room sequentially. These are the recommended configurations:

Automated Sequential Measurement
Configuration is remotely controlled by one person:

1x Dodecahedron Speaker Set;

1x Acoustic Analyzer (XL3 Acoustic Analyzer or XL2 Acoustic Analyzer);

1x M2230 Measurement Microphone;

With XL3 Acoustic Analyzer:

1x Sound Insulation Option;

With XL2 Acoustic Analyzer:

1x Extended Acoustic Pack;

1x Sound Insulation Option;

1x Remote Measurement Option;

1x ASD Cable 5m (alternatively 10m or 20m);

1x Mains Power Adapter (XL3 Acoustic Analyzer or XL2 Acoustic Analyzer)
(optional);

1x Exel System Case (optional);

1x Windows Computer, Laptop or Tablet (to start/stop measurements live in Sound
Insulation Reporter);

1x Wi-Fi Access Point (generating Wi-Fi network, e.g. SILEX SX-ND-4350WAN) or
USB Device Server (using existing Wi-Fi network); available at your preferred sup-
plier.

3.3.3 Configuration

3.3.3.1 Speaker and Microphone Configuration

The sound spectra in the source room and the receiving room are measured simultaneously
by individual XL2 Acoustic Analyzer. The Sound Insulation Reporter Software controls the
instruments and visualizes the live measurement data.
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3.3.3.2 Measuring with XL3 Acoustic Analyzer

To perform the measurement using wireless connectivity with the XL3 Acoustic Analyzer,
you need to set up the hotspot/access point to which you will connect your Sound Level
Meter (SLM) and the PC that will control the unit. After that, the Sound Insulation Reporter
will detect your XL3 Acoustic Analyzer in the window:
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After completing the settings on the Connect page, pressOK. You can then define the type
of measurement and the room where the device is positioned. Then press to perform the
measurement remotely.

3.3.3.3 Measuring with XL2 Acoustic Analyzer

3.3.3.3.1 Case A) Instrument Configuration "External Wi-Fi network available"

If a Wi-Fi network is already available at the measurement location, you may connect the
XL2 Acoustic Analyzer (and optionally the PA3 power amplifier) in the source room to the
controller PC (notebook) in the receiving room by using a Wi-Fi connected USB Server.

3.3.3.3.2 Case B) Instrument Configuration "Local Wi-Fi network"

If no external Wi-Fi network is available, you may establish your own local Wi-Fi network by
using a portable Wireless Access Point. This device connects the XL2 Acoustic Analyzer
(and optionally the PA3 power amplifier) in the source room to the controller PC (notebook)
in the receiving room.

3.3.3.3.3 Recommended setup procedure for Wireless Access Point "SILEX SX-ND-
4350 WAN"

1. Download and install the “SX Virtual Link" software;

2. Connect the SILEXWireless Access Point to AC mains;
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3. Connect the XL2 Acoustic Analyzer via a USB cable to the SILEXWireless Access
Point, and optionally also the PA3 via an Ethernet cable;

4. Switch ON the XL2 Acoustic Analyzer, select the “COM port” mode and wait, until the
LED on the SILEXWireless Access Point starts flashing;

5. Run the SILEX SX Virtual Link software on the controller PC (notebook);

6. In the control panel of the SILEX SX Virtual Link software, click on “NTi Audio AG XL2
Remote’ then on the “Connect” button.

7. Right click on "NTi Audio AG XL2 Remote” to open the "Remote Properties” panel;
therein, click on “Device Server Properties”.

8. Press the Enter key to log in (no password required);

9. Adjust the settings as shown on the next page.
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3.3.3.3.4 Product Configuration for Wireless Access Point type "SILEX SX-ND-4350
WAN"

1. Select the menu “Product Configuration";

2. Make sure that the DHCP Client is switched to “DISABLE” and the DHCP Server Func-
tion to “ENABLE”;

3. Click on “Submit” to confirm the settings;

4. Toggle to the SIR software and verify, whether the XL2 Acoustic Analyzer instruments
are connected properly.
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3.3.4 Selecting Standard and Type of Sound Insulation

Start the Sound Insulation Reporter software;

Click on File -> New,

Select your requested Standard;

Select Airborne, Impact or Facade Sound Insulation;

Select the number of Speaker positions used;

Select Unit;

Define the required Results;

Select the preferred Rating Format, Choose either Dw(C;Ctr) = 41 (1-3) dB or Dw =
40.5 dB +/-0.9 dB;

Confirm withOK.

3.3.5 Preparing the Measurement

Click on Connect... in the toolbar.
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The Sound Insulation Reporter software detects all available XL3 Acoustic
Analyzer and XL2 Acoustic Analyzer(connected in the COM-port mode);

Verify the connected Acoustic Analyzer.

For XL3 Acoustic Analyzer, the status will validate if a valid license is
applied for the Sound Insulation Option or if the Sound Insulation Reporter
365 is enabled. Please ensure that you have an active internet connection
while using the XL3;

For XL2 Acoustic Analyzer, the status will validate if a valid license is
applied for the Extended Acoustic Pack, Remote Measurement Option, and
Sound Insulation Option, or if the Sound Insulation Reporter 365 is enabled.

Tick Simultaneous measurement in source and receiving room as applicable.
This selection is dedicated for parallel measurements in source and receiving room
with one or more instruments, Assign at least one device to the source room and
another one to the receiving room. This is applicable for airborne or facade sound insu-
lation measurements.
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The PA3 Power Amplifier for the Dodecahedron Speaker DS3 may also be remotely
controlled. For this purpose, you may connect the PAS using a LAN cable to the:

LAN network for a fixed permanent installation;

Wi-Fi access point for an onsite temporarly installation.

Select Use for Spectrum and Reverberation Time measurements;

Click on Refresh;

The IP number of the connected PA3 Power Amplifier is displayed (Connected to
xx.xxx.x.xx)
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Verify the firewall settings on the connected computer; the access to the displayed IP
address has to be enabled. In case of the message A critical error occurred is
shown at the start of your next measurement, then disable the firewall for evaluation
shortly;

Confirm your settings withOK.

3.3.6 Sound Spectrum Measurement

Select the measurement in the drop-down menu, e.g. L1-1, L2-1 for simultaneous
measurement of sending and receiving room at speaker position 1,
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Press Start in the toolbar;
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The remote measurement is started, The actual levels are visualized in the soft-
ware.
Sending Room
Serial number of the Acoustic Analyzer assigned to sending room and meas-
urement timer.
Receiving Room
Serial number of the Acoustic Analyzer assigned to receiving room and meas-
urement timer.

The measurement stops automatically after the preset measurement duration;

Move the microphone position and continue with the next measurement;

Follow the same procedure for the second speaker position and the background noise
recording.
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3.3.7 Reverberation Time Measurement

Select T2 for the reverberation time measurement in the toolbar.

Press Start in the toolbar;

Activate the dodecahedron speaker with pink noise or the impulse sound source;

The XL2 Acoustic Analyzer measures the reverberation time. The averaged test
result is visualized in the software.

Press Stop in the toolbar;

The reverberation time measurement is completed.

Move the microphone position and continue with the next measurement;

Verify the measurement data and delete any false readings from theMeasurements
list on the right.
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3.3.8 Measurement Report

Select View -> Calculations in the menu.

Verify the individual averaged results.

Select the View -> Results.

The sound insulation data and chart are displayed.
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Complete the header data with information about client, object, description, partition
area and room volumes;

Print the sound insulation report.

Congratulations, your report is completed!
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4 Sound Insulation Report

The software generates automated reports in accordance with the supported standards.
Print the reports for the selected results.
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4.1 Site View
Site View mode is a powerful workspace where you can display and edit all measured par-
titions at once. The side view mode also displays rating, target and compliance. These fea-
tures were added in the Version 1.50 of the Sound Insulation Reporter. The following video
provides a detailed explanation of the Site View feature: New features in Sound Insulation
Reporter 1.50.

In the Site View mode you can import your data that has been measured using XL3 Sound
Insulation Option, so it will be displayed at least where you can edit specific information
about your measurements. If you prefer the legacy workflow you can, just click to New Par-
titions button to import your measurements and continue working as before.

The Site View mode offers several features that enhance the efficiency of managing sound
insulation measurements. One of the key functionalities is batch editing, which allows users
to edit multiple parameters across various partitions simultaneously. This includes the ability
to modify details such as the source room and receiving room names, as well as the volume
or area of the common partition.
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Additionally, the Site View mode incorporates features for rating, target, and compliance
assessment. Users can quickly determine whether their results meet the necessary criteria
through intuitive pass and fail indicators, streamlining the evaluation process.

Another significant feature is report preview , which enables users to generate com-
prehensive reports for all partitions directly from the side view. This functionality simplifies
documentation and analysis, making it easier to track and present results.
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For data management, the Site View mode allows for data export , enabling users to
select specific partitions and export them into Excel files for further analysis. This capability
ensures that data can be easily manipulated and shared as needed.

Moreover, users can import B2 and T2 results from other measurements, provided they
relate to the same receiving rooms. This functionality promotes data consistency and saves
time when working across multiple tests, enhancing overall workflow efficiency.

The Site View mode also supports the addition of custom targets. Users can define manual
targets alongside predefined standards, allowing for easy customization and quick access to
target presets whenever required. Furthermore, it is possible to set manual targets for indi-
vidual tests or select multiple tests in the side view mode to apply a target to all selected
tests, providing flexibility in managing measurement criteria.
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File Change Site... Allows you to switch to a different site, enabling you to
manage and organize measurements across various pro-
jects.

Refresh Site Updates the current site view to reflect any recent changes
or new data, ensuring that you are working with the most
current information.

New Par-
titions...

Initiates the import process for new measurements, allow-
ing you to add partitions to your current project while main-
taining the legacy workflow.

Open Partition Enables you to access and edit specific partitions within
the current site, providing detailed information and options
for modification.

Delete Par-
titions...

Allows you to remove selected partitions from the site
view, streamlining your project by eliminating unnecessary
data.

Import Sound
Insulation on
XL3

Select the Sound Insulation file (.xl3si) generated during
measurements conducted in Sound Insulation Option on
the XL3. This file contains all predefined information
regarding the measurements, as well as details about the
rooms or partitions specified in the XL3 Acoustic Analyzer.

Export to
Excel...

Export all measurement data and results into MS Excel.
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Preferences... General
The Sound Insulation Reporter software is available in
Chinese, English and German language. Additionally, the
reporting is offered in the languages Czech and Italian.
The default setting use the language of the operating sys-
tem installed on your computer. Select the language as fol-
lows:

Select File in the menu;

Select Preferences...;

Select the language. Changing the language will
require a restart of the software;

Confirm the settings withOK.

The software closes and restarts with the selec-
ted language.

Site
This option allows you to configure the site columns dis-
played in the Site View. You can customize the visibility of
the following columns:

Column Name: The identifier for each column.

Name: The name of the site or project.

Standard: The applicable standards for sound insu-
lation measurements.

Type: The type of measurement or partition.

Client: The name of the client associated with the
project.

Location: The geographical location of the site.

Date of Test: The date when the measurements
were conducted.

Date: The date of data entry or modification.

Partition Summary: A brief overview of the meas-
ured partitions.

Transmission Direction: The direction of sound
transmission between rooms.

Building Type: The classification of the building
(e.g., residential, commercial).

Area of Common Partition: The area of shared
partitions between rooms.

Pass according to Rating result and its Target

Fail according to Rating result and its Target
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Enter any applicable frequency response correction
for the used measurement microphones here with
type and serial number. The unit is [dB]. This cor-
rection is automatically applied at the import of any
data recorded with this microphone or any remote
measurements performed. Sound Insulation
Reportercalculates (measurement result + cor-
rection) for each frequency band and presents the
result in the chart. The data set requires to list the
same type and serial number in the header data in
order to detect the microphone type and serial num-
ber.

Note: the correction is not applied on any existing
projects.

XL3 Manager
The XL3 Manager allows you to manage your XL3 devices
efficiently. Within this section, you can perform the fol-
lowing actions:

New...:Create a new entry for an XL3 device. You
will need to fill in the following fields:

Serial Number: Enter the unique serial number
of the XL3 device.

Password: Provide the password associated
with the device.

Edit...:Modify the details of an existing XL3 device
entry.

Delete...:Remove an existing XL3 device entry from
the list.

If automatic discovery of the XL3 device is not available,
you can manually enter the IP address. The following field
is provided for this purpose:

IP Address: Enter the IP address of the XL3 device.

Additionally, there is a Test IP option that allows
you to verify the connectivity to the specified IP
address.

Rating Target
Configure the Rating Target or select a predefined Rating
Target from the list (Preferences > Rating Target) to
assess the compliance of your measurement against
established expectations.

71



4 Sound Insulation Report

The outcome will be presented as a Pass/Fail result in the
Compliance column.

Pass according to Rating result and its Target

Fail according to Rating result and its Target

Exit Close the software.
Help Online Help Link to download the user manual in PDF form.

Check for
Updates...

Checks for available updates of the Sound Insulation
Reporter software.

Download Demo
Data...

This option allows you to download sample meas-
urement data for demonstration purposes. This demo
data can be used to familiarize yourself with the fea-
tures and functionalities of the Sound Insulation
Reporter without the need for actual measurements.

About List's version and copyright details of the software.

4.2 Main Menu

4.2.1 Toolbar
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New Project

A project contains the measurement data of one partition. The airborne or impact
sound insulation of a new project is calculated in accordance with the selected
standard.

Select the number of Speaker positions used for the measurements with
the XL2 Acoustic Analyzer or ;

Select Unit;

Select the Results required;

Select the preferred Rating Format for the standards BB93, DIN4109, ISO
16283, ISO 10140 and SIA 181. By default is the single number rating
provided in 1.0 dB steps in all standards, e.g, Dw(C;Ctr) = 41 (-1;-3) dB,
Alternatively, the standards BB93, DIN4109, ISO 16283, ISO 10140 and
SIA 181 may show the single number rating in 0.1 dB steps with meas-
urement uncertainty, e.g, 40,5 dB +/- 0.9 dB;

Confirm the settings withOK.
Open Project File

Select an existing project file *.xlba.
Save Project File

Save the actual sound insulation data as project file *.xlba.
Import

Select the folder containing the original XL2 Acoustic Analyzer or XL3
Acoustic Analyzer measurement data *.txt, *.xl2 and *.xI3sifiles and confirm
with "Select folder". All measurement files within the selected folder are
imported into the software. Any recorded data with A- or C-weighting is auto-
matically corrected to Z-weighting (=no weighting).

Export to Excel

Exports all measurement data and results into MS Excel.
Print Preview

The sound insulation reports for the selected results are displayed.
Print

The sound insulation reports for the selected results are printed.
Measurement View

The original XL2 Acoustic Analyzer or XL3 Acoustic Analyzer meas-
urements data is visualized in the frequency range from 50 Hz to 5 kHz. By
default, all measurement data, as well as the speaker position for the sound
insulation calculation, are automatically assigned to the corresponding send-
ing or receiving room. Alternatively, the data can be assigned manually.
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Calculation View

Displays the average of the:

sending room level for each speaker position;

receiving room level for each speaker position;

background noise level;

reverberation time.
Results View

Displays the following sound insulation results based on the selected result
type:

table from 50 Hz - 5 kHz;

standardized chart from 50 Hz - 5 kHz;

single number sound insulation rating;

rating corrections Cxx.
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Settings

General Select the number of Speaker positions used for the
measurements;

Select Unit;

Select the Results required.
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Mapping Sound insulation measurements require the recording of mul-
tiple noise spectras in the sending and the receiving rooms.
The XL2 Acoustic Analyzer with firmware V4.03 or higher sim-
plifies the data handling of these measurements by recording
each data set with a dedicated location mapping, such as “L1-
1” for a measurement carried out in the sending room with
speaker position 1. Storing the measurement data with this
mapping on the XL2 supports the automated data assigning to
the corresponding room and speaker position during the data
import into the Sound Insulation Reporter software.

Click on Export..., this generates the text file save-
names.txt;

Load the txt-file "savenames.txt" with the various map-
pings, like "L1-1", "L1-2"... onto the SD card of the XL2
Acoustic Analyzer;

Copy this file onto the root directory of the XL2 Acoustic
Analyzer memory card;

Select the memory menu on the XL2 Acoustic Analyzer
and set Autosave: Off.

Each measurement can be manually stored on the
XL2 Acoustic Analyzer with one of the predefined
mappings.
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Charts Spectrum Set the Y-axis scaling for meas-
urements and calculations view;

Reverberation Time Set the Y-axis scaling for meas-
urements and calculations view;

Results Set the Y-axis scaling for the
chart in results view. The default
sapn is 60 dB.
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Report Load your company logo for the printed measurement
reports;

Align title to the left offers more space for your com-
pany logo in the report header;

Show Appendix enables an appendix field in the report
header; this allows adding the report with an appendix
number to a longer report;

Hide equipment offers more space for the description in
the report.

Hide area of common partition is e.g, used in applic-
ations without a common partition;

Hide source room volume offers also more space for
the description in the report;

Set the Name of the test institute, e.g. your company
name;

Load your Signature for the print measurement reports.

The recommended maximum size for the imported picture is

Logo: 120 x 30 px, 96 dpi
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Signature: 350 x 70 px, 96 dpi
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Connect

Select the SLM measurement duration (default = 15 seconds);

The standard ISO 16283 lists a minimummeasurement duration for fixed
microphone positions of:

6 seconds for the frequency range 100 Hz - 5000 Hz;

15 seconds for the frequency range 50 Hz - 5000 Hz.

Select the Reverberation Time input range (default = High);

Select the Reverberation Time method (default = T20);

Click Refresh to detect the connected XL2 Acoustic Analyzer or XL3 Acous-
tic Analyzer

Simultaneous measurement in source and receiving room
This selection is dedicated for parallel measurements in source and
receiving room with one or more instruments. Assign at least one
device to the source room and another one to the receiving room for air-
borne or facade sound insulation measurements. The Sound Insulation
Reporter software may operate multiple instruments at the same time.

Measuring with one or more instruments in the same room:

Do not select Simultaneous measurement in source and receiving
room;

Assign the applicable instruments to Any.
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Microphone:

Arrows next to the serial number indicate, that the assigned micro-
phone correction will be applied. This may be set at File -> Prefer-
ences... -> Microphone Corrections.

The Status column list one of the following information:

Valid Licence;

Upgrade required;

Unassigned Device (XL2 Acoustic Analyzer or XL3 Acoustic Analyzer
will not be used to measure);

Not Connected (the XL2 Acoustic Analyzer or XL3 Acoustic Analyzer
was previously connected and assigned to the specified room; if you for-
got to connect it, then place it in the assigned room, connect it and click
Refresh; if you don't want to use this device anymore, the ignore this
message).

PA3 Power Amplifier

Tick this setting to remotely control the PA3 power amplifier for the Spec-
trum and Reverberation Time measurements, which needs to be connected
via LAN or Wi-Fi to the network;

Set the Reverberation Time measurement cycle duration from 1 to 10
seconds.

Start Remote Measurement

Start here the selected measurement. The measurement will automatically
stop after the preset measurement duration.

Select Measurement

Select one of the following measurements at airborne sound insulation test-
ing:

L1-1, L2-1 (sending & receiving room simultaneously @ speaker pos-
ition 1);

L1-2, L2-2 (sending & receiving room simultaneously @ speaker pos-
ition 2);

B2 (background noise);

T2 (reverberation time).
Stop Remote Measurement

Stop here selected measurement prior the automated stop according the
preset measurement duration.

4.3 Menu
The software offers the following menu functionalities:
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File Site Provides a dedicated workspace for displaying all
measured partitions. This view enables simultaneous
editing of multiple partitions and functions as a repos-
itory for storing all measurements associated with a
specific project.

New Partition... A project contains the measurement data of one par-
tition. The airborne or impact sound insulation of a
new project is calculated in accordance with the selec-
ted standard:

Select the number of Speaker positions used
for the measurement with the XL2 Acoustic Ana-
lyzer or XL3 Acoustic Analyzer;

Select Unit;

Select the Results required;

Select the preferred Rating Format for the
standards BB93, DIN4109, ISO 16283, ISO
10140 and SIA 181. By default is the single num-
ber rating provided in 1.0 dB steps in all stand-
ards, e.g. Dw(C;Ctr) = 41 (-1;-3) dB. Altern-
atively, the standards BB93, DIN4109, ISO
16283, ISO 10140 and SIA 181 may show the
single number rating in 0.1 dB steps with meas-
urement uncertainty, e.g. 40.5 dB +/- 0.9 dB;

Confirm the settings withOK.
Open Par-
tition...

Select an existing project file *.xlba.

Save Partition Save the actual sound insulation data as project file
*.xlba.

Save Partition
as...

Save the project with selectable name and path.

Print Preview The sound insulation reports for the selected results
are displayed.

Print... The sound insulation reports for the selected results
are printed.
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Import Folder... Select a folder in order to import
all measurement data stored in
this folder.

File... Select a single measurement data
file *.xl2 or *.xI3si.

Airborne

Difference...

Applicable for standard DIN 4109
only. Select an airborne sound
insulation project based on DIN
4109.

Any recorded data with A- or C-weighting is auto-
matically corrected to Z-weighting (=no weighting).

Import Sound
Insulation on
XL3

Select the Sound Insulation file (.xl3si) generated dur-
ing measurements conducted in Sound Insulation
Option on the XL3. This file contains all predefined
information regarding the measurements, as well as
details about the rooms or partitions specified in the
XL3 Acoustic Analyzer.

Export to
Excel...

Export all measurement data and results into MS
Excel.
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Preferences... General
The Sound Insulation Reportersoftware is available in
Chinese, English and German language. Additionally,
the reporting is offered in the languages Czech and
Italian. The default setting use the language of the
operating system installed on your computer. Select
the language as follows:

Select File in the menu;

Select Preferences...;

Select the language. Changing the language
will require a restart of the software;

Confirm the settings withOK.

The software closes and restarts with the
selected language.

Microphone Corrections

Enter any applicable frequency response cor-
rection for the used measurement microphones
here with type and serial number. The unit is
[dB]. This correction is automatically applied at
the import of any data recorded with this micro-
phone or any remote measurements performed.
Sound Insulation Reportercalculates (meas-
urement result + correction) for each frequency
band and presents the result in the chart. The
data set requires to list the same type and serial
number in the header data in order to detect the
microphone type and serial number.

Note: the correction is not applied on any exist-
ing projects.

Recent Select a recently-opened project.
Exit Close the software.

85



4 Sound Insulation Report

Edit Cut Cut the text from any text box.
Copy Copy the data selected in the right-handMeas-

urements, Calculations or Results box.
Paste Paste the copied text into any text box.
Delete Delete the data selected in the right-hand selection

box inMeasurements.
Select All Select all data in the right-handMeasurements

box (applicable in Measurements View only).
Deselect All Deselect all earlier selected data in the right-hand

Measurements box (applicable in Measurements
View only).

Rating Target... Configure the Rating Target or select a predefined
Rating Target from the list (Preferences > Rating
Target) to assess the compliance of your meas-
urement against established expectations.

The outcome will be presented as a Pass/Fail res-
ult in the Compliance column.

Pass according to Rating result and its
Target
Fail according to Rating result and its
Target

View Measurements Select the Measurements View.
Calculations Select the Calculation View.
Results Select the Results View.
Settings Opens the Project Settings window.

Measure Connect... Opens the window Connect.
Start Starts the selected measurement.
Stop Stops the select measurement.
Measurements
e.g. L1-1/L2-1

Select the measurement.

Help Online Help Link to download the user manual in PDF form.
Check for
Updates...

Checks for available updates of the Sound Insu-
lation Reporter software.

About List's version and copyright details of the software.
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4.4 Analysis and Reporting Views
The Sound Insulation Reportersoftware offers three views for fast data analysis and straight-
forward reporting in accordance with the standard.

Measurements View

Calculations View

Results View

4.4.1 Measurement View
By default, all measurement data are automatically assigned to the corresponding sending
or receiving room, as well as the speaker position for the sound insulation calculation. Altern-
atively, the date can be assigned manually.
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Details

Header data of the Sound Insulation Reporter. The partition area and
volume parameters are used for the sound insulation calculation.

Spectrum Measurements Chart

The original XL2 Acoustic Analyzer measurement data is visualized in the
frequency range from 50 Hz to 5 kHz.

Y-Axis of Spectrum Measurements Chart

Set the Y-axis in Settings -> Charts.
X-Axis of Spectrum Measurements Chart

The X-axis is fixed to 50 Hz - 5 kHz.
Reverberation Time Measurements Chart

The original XL2 Acoustic Analyzer measurement data is visualized in the
frequency range from 50 Hz to 5 kHz.

Y-Axis of Reverberation Time Measurements Chart

Set the Y-axis in Settings -> Charts.
Guideline Bar

Additional information about displayed measurement data is listed here.
X-Axis of Reverberation Time Measurements Chart

The X-axis is fixed to 50 Hz - 5 kHz.
Standard

Selected standard for the sound insulation calculation and reporting.
Speaker Positions

Reads the number of set speaker positions.
Single Number Sound Insulation

Reads the single number results. Select the calculated results in Settings -
> General.

Measurements List with Mappings

List all the imported XL2 Acoustic Analyzer measurement data files with the
automatically-assigned mapping. The mapping may be assigned manually
to sending room or receiving room and the individual speaker positions:

Select the measurement with the mouse;

Click on the right mouse button;

Select Assign To;

Assign the measurement.
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Image

Click into the image field and load a drawing or picture describing the par-
tition. The recommended maximum size is for:

A4 Reporting: 340 x 160 px;

Letter Reporting: 350 x 130 px.

4.4.2 Calculations View
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Details

These data are listed in the header of the Sound Insulation Reporter. The
partition area and volume parameters are used for the sound insulation cal-
culation.

Chart

The averaged measurement data for sending room, receiving room and indi-
vidual speaker position is visualized in the frequency range from 50 Hz to 5
kHz.

Y-Axis

Set the Y-axis in Settings -> Charts.
Guideline Bar

Additional information about displayed measurement data is listed here.
X-Axis

The X-axis is fixed to 50 Hz - 5 kHz.
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Standard

Selected standard for the sound insulation calculation and reporting.
Speaker Positions

Reads the number of set speaker positions.
Single Number Sound Insulation

Reads the single number results. Select the calculated results in Settings -
> General.

Differences

Select Difference D-1 and view the averaged sending room, averaged
receiving room and the calculated difference for the speaker position 1. Any
applicable background noise correction is included by default.

Average

Averaged data sets for sound insulation calculation

Select e.g. Average L1-1 for detailed verifications of the measurement data
used for the average calculation

Press ESC on the keyboard to return to the default view with all averaged
measurements.

Detailed View

Displays all measurement data and the averaged result for the selected
parameter.

Measurement Selection

Disable any measurement data, which shall not be used for the average cal-
culation.

Selected Average Parameter

Select the parameter for detailed analysis.

4.4.3 Results View
The results view displays the following sound insulation results based on the selected result
type:

Table from 50 Hz - 5 kHz;

Standardized chart from 50 Hz - 5 kHz;

Single number quantity;

Spectrum adaptation terms C and Ctr.
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Details

These data are listed in the header of the sound insulation report. The par-
tition area and room volume parameters are used for the sound insulation
calculation.

Results

Sound insulation results in the frequency range from 50 Hz to 5 kHz;

The fixed background noise correction of 1.3 dB is automatically applied in
case the receiving room level differs by less than 6 dB from the background
noise level, e.g. in accordance with ISO 16283. In case this fixed correction
is applied, then the applicable frequency bands are marked by the symbol ≤
or ≥; see .
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Information about Background Noise Correction

A fixed background noise correction applied in the table at frequency
bands marked by the symbol ≤ or ≥.

Guideline Bar

Additional information about displayed measurement data is listed here.
Results Chart

Sound insulation results spectrum with shifted reference curve in the fre-
quency range from 50 Hz to 5 kHz.

Standard

Selected standard for the sound insulation calculation and reporting.
Speaker Positions

Reads the number of set speaker positions.
Single Number Sound Insulation

Reads the single number results. Select the calculated results in Settings -
> General.

Spectrum Adaption Terms
Value, in decibels, to be added to the single-number rating (e.g. R'w) in accord-
ance with ISO standards. These take into account different spectra of noise
sources; such as pink noise (C) and road traffic noise (Ctr).

Application examples:

C:

Living Area Noise (talking, music, radio, TV), trains at middle and high
speed, highway traffic @ speed > 80 km/h, jets in near distance, factor-
ies with mainly middle- and high-frequency noise.

Ctr:

traffic noise in cities, trains at low speed, jets in far distance, airplanes,
factories with mainly low-frequency noise.
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Single Number Quantity

This is the single number sound insulation result. The single number result
equals the level of the shifted reference curve at 500 Hz;

Select the preferred Rating Format for the standards BB93, DIN4109, ISO
16283, ISO 10140 and SIA 181. By default is the single number rating
provided in 1.0 dB steps in all standards, e.g, DwiC;Ctr) = 41 (-1;-3) dB.
Alternatively, the standards BB93, DIN4109, ISO 16283, ISO 10140 and
SIA 181 may show the single number rating in 0.1 dB steps with meas-
urement uncertainty, e.g. 40.5 dB +/-0.9 dB.

When you click on Rating, you can add a Rating Target, which will later
appear in the Site View to indicate whether the results are in compliance.

The outcome will be presented as a Pass/Fail result in the Compliance
column.

Pass according to Rating result and its Target

Fail according to Rating result and its Target

Result Selector Box

Select the required sound insulation result here. The available results are
preset in Settings - > General.

4.5 Export Measurement Data
Click on the "Export to Excel..." button in the menu bar. This exports all measurement data
and results into MS Excel. Alternatively, you may export individual data and charts for user
defined analysis and reporting as follows:

Select the required result or data set in the right-hand column and click with the right
mouse key,
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Select Copy or Copy values. Copy selects the data with headers - Copy values just
the data;

Alternatively press CTRL+C on the computer keyboard;

Open the application e.g. Microsoft Excel;

Press CTRL+V on the computer keyboard for the data or Paste Special for the chart.

The selected measurement data is exported.

4.6 Re-Use and Edit Data
This chapter describes how measurement data may be imported from other projects and
how reverberation time date may be duplicated and edited.

4.6.1 Add Data from other Projects
Measurement data may be imported from other projects. This allows to re-use the same
background noise or reverberation time data of the receiving room for multiple projects; e.g.
in case the sound insulation from rooms left, right or on top of the receiving room shall be
evaluated. Also, data recorded directly by the Sound Insulation Reporter software by auto-
mated measurements may be re-used in this manner.
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How to import data from another project?

Select File -> Import -> Measurements from Project;

Select your existing Sound Insulation Reporter Project;

All data of the selected project is imported into the existing project.

You may delete any non-required data;

Verify the assignment of the imported data.

4.6.2 Edit reverberation time data
Reverberation time data sets may be incomplete, e.g. due to insufficient sound energy in the
room in lower frequency bands. The Sound Insulation Reporter software allows to duplicate
a reverberation time data sets and edit them for evaluation. The original data set remains
available.

How to duplicate and edit reverberation time data?

Select the Measurement View;

Click with the right-mouse-button on a reverberation time measurement;

Select Duplication to Edit...; the Edit Measurement panel opens;

Edit name and data values;

Press OK to store your changes;

Delete the original data set or disable it in the Calculations View from the average cal-
culation.

4.7 Standard ISO 16283

4.7.1 Low Frequency Procedure for Rooms < 25 m3
The following applies:

First a room volume < 25 m3 has to be entered. Then the measured data may be
assigned in accordance with the low frequency procedure;

The reverberation time of the 63 Hz octave band is calculated based on linear average
of measured 50 Hz, 63 Hz and 80 Hz frequency bands.

4.7.2 Measurement of Doors
For the measure the sound insulation of doors the following has to be observed:

The area of common partition is the area of the free opening in which the door, includ-
ing its frame, is mounted;

The apparent sound reduction index of a door measurement is correct in case all the
sound is transmitted through the door area;
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A second sound insulation measurement is required in order to check the flanking
transmission by fitting the door with additional sound insulation. The measured sound
insulation is stored as reference;

The reference data from the second measurement may be loaded into the project of
the door under test by selecting File -> Import -> Reference R'...;

Compare the sound insulation of the door under test and the reference in the Cal-
culations view;

The Results view presents the apparent sound insulation R' including any applicable
corrections.

4.8 Standard DIN 4109

4.8.1 Airborne sound transmission correction at impact insulation assessments
The standard DIN 4109 can be selected at the start of a new project. The functionalities and
calculations are identical to the standard ISO 16283. Additionally, is the German require-
ment to perform an airborne sound transmission correction at impact insulation assess-
ments listed in Appendix A of DIN 4109-4:2016.

In case a high airborne sound level is generated by the tapping machine in the sending
room, then the measured impact noise level in the receiving room can be influenced by the
airborne noise transmission through the partition under investigation. Follow these steps to
include the correction for the airborne sound transmission:

Assess the airborne sound insulation D between the two partitions (create a new pro-
ject and select the standard DIN 4109);

Verify the impact sound insulation without any airborne sound correction;

Measure the sound pressure level of the tapping machine in the sending room and
assign the data sets to the sending room L1 in the software;

Select in the menu File -> Import -> Airborne Difference... and choose the project
with the airborne sound insulation D;

The project with the airborne sound insulation D is loaded and the correction
applied for the impact sound insulation calculation.

Evaluate the effect with or without airborne sound transmission correction by deleting
the Airborne Difference D in theMeasurements view and import this correction
again as required.

4.8.2 Airborne sound transmission testing of doors from apartments to stair cases
or corridors
The stair case or corridor is used as sending room. The sending room level is measured by
scanning the level in front of the door. This measurement method requires a 3 dB correction
to default measurements in the room.
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4.8.3 Measurement of the airborne sound insulation of external components in the
building
The Sound Insulation Reportersoftware calculates the sound reduction index R' according to
the angle used by the loudspeaker to the perpendicular of the test object. One of the fol-
lowing measurements methods may be selected:

Element Loudspeaker method:

flush-mounted microphone close to the test surface;

the sound reduction index R' is calculated according to DIN 4109-4 (formula B.2):

Global Loudspeaker method:

microphone mounted 2 m in front of the building;

athe sound reduction index R' is calculated according to DIN 4109-4 (formula
B.3):

Where:

L1 sound pressure level on the surface of the test object [dB]
L'1 sound pressure level at 2 m in front of the test object [dB]
L2 sound pressure level in the receiving room [dB]
S area of the test item
T reverberation time
V volume of the reception room
δ angle of the loudspeaker to the vertical perpendicular of the test object

4.9 Standard ISO 10140
ISO 10140 specifies a laboratory method for measuring the:

airborne sound insulation of building products, such as walls, floors, doors, windows,
shutters, façade elements or façades;

impact sound insulation for floor assemblies.

4.9.1 Flanking Transmission at Airborne Sound Insulation
In laboratories complying with ISO 10140-5, ensure that the sound transmitted by indirect
paths is negligible compared with the sound transmitted through the test element. A pre-
liminary test shall be carried out to ensure that sound power transmitted through the sur-
rounding partition is small compared with the sound power transmitted through the test ele-
ment.
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Select the applicable test arrangement in the Project Settings:

Full-size test opening;

Reduced-size opening (building element);

Reduced-size opening (technical element).

Measure the maximum airborne sound insulation of the test stand and store the pro-
ject data as reference;

Install the test element and perform the sound insulation test;

The reference data may be loaded into the project of the test element by selecting File
-> Import -> Reference Level ...;

Compare the sound insulation of the test element and the reference in the Cal-
culations view;

The Results view presents the apparent sound insulation R' including any applicable
corrections.

4.9.2 Floor coverings - Improvement of Impact Sound Insulation
The Sound Insulation Reporter software allows evaluating the weighted reduction in impact
sound pressure level ΔL. This is the impact sound insulation improvement of a floor under
test compared to a reference floor.

Measure the impact sound insulation of the reference floor and save the data in a pro-
ject;

Open a new impact sound insulation project and activate ΔL as result;

Measure the impact sound insulation of the floor under test;

Select File -> Import -> Reference Level Ln...;

Select the reference floor project. Now the reference level Ln is imported and dis-
played in the measurements view;

Switch to the results view and select the result ΔL;

Set the Y-scaling in the Settings-Charts menu as required.

4.10 Standard BB93
Building Bulletin 93 (BB93) explains minimum performance standards for the acoustics of
school buildings in the UK. The latest edition is dated February 2015. The sound insulation is
measured and reported in accordance with ISO 16283.

For the purpose of the assessment the mid-frequency reverberation time Tmf may be edited
in accordance with BB93, which lists the maximum expected reverberation time of the fin-
ished and unfurnished room. The Tmf is the is the arithmetic average of the reverberation
times in the 500 Hz, 1 kHz and 2 kHz octave bands, or the arithmetic average of the rever-
beration times in the one-third octave bands from 400 Hz to 2.5 kHz. In practice the dif-
ference between the measured and listed Tmf will be small. This is acceptable in the
interests of simplicity and ease of measurement.
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4.11 England/Wales: Approved Document E (2003)
Approved Document E provides guidance on the resistance to the passage of sound in
domestic buildings, in schools and flats. This guidance applies to new buildings, to alter-
ations to pre-existing premises and to buildings being converted to flats in the England and
Wales. The latest amendment has been made in 2015.

It specifies to measure the sound insulation in accordance with the standard series ISO 140.
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5 Revision-History

5.1 Release V1.47, Oct 2024
Chinese standard GB/T 19889:2022;

Remote measurement:

Support XL3 Acoustic Analyzer.

General:

Show insulation results after first measurement/speaker position.

Reporting:

Language Lithuanian.

5.2 Release V1.40, Nov 2022
XL3 Acoustic Analyzer:

Import measurement data;

Import sound insulation projects (File -> Sound Insulation on XL3 Acoustic Ana-
lyzer...).

General:

Import and drag&drop of zip files;

Rounding of spectrum adaption terms in accordance with ISO 717.

Reporting:

Language Latvian.

5.3 Release V1.36, Nov 2021
Dutch standard NEN 5077:2019;

Swiss standard SIA181:2020;

Updated ASTM E336 to latest release 2020;

Façade Sound Insulation:

Global and Element Loudspeaker method;

Signal sources Road Traffic, Railway Traffic and Aircraft Traffic.

ISO 16283:

Airborne sound insulation of doors;

Rating result for impact source "Rubber Ball";

Low frequency procedure for rooms < 25 m3 calculates reverberation time as lin-
ear average of 50 Hz, 63 Hz and 80 Hz frequency bands.
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ISO 717:

Spectrum adaption terms for rating format 0.1 dB calculated according to ISO
717-1:2020.

ISO 10140:

Impact source "Rubber Ball";

Include flanking transmission.

DIN 4109:

Calculate Sound Insulation Index R' for "Global" measurement method;

Remote measurement:

Support spectrummeasurements without optional Extended Acoustic Pack
installed.

Reporting:

Values at the limit of measurement are marked by ≤ or ≥;

Languages Dutch, French, Korean, Swedish;

Optimized chart and scaling;

Increased maximum room volume.

5.4 Release V1.30, Dec 2019
Enable copy and edit Reverberation Time data;

Import measurement data from other projects (re-use live measurements for different
standards);

Impact sound pressure level reduction ΔLw for ISO 10140;

Standard BB93, Acoustic Design of Schools;

Updated measurement uncertainty according to ISO 12999-1:2014 for DIN 4109, ISO
16283, ISO 10140 and SIA 181;

Standard DIN 4109:

Door scanning method for airborne sound insulation;

Simultaneous measurement of send and receive room for impact sound insu-
lation;

List frequency bands with airborne noise correction for impact sound insulation
measurements;

Angle of incidence for façade sound insulation.

Remote measurement:

Extended measurement duration settings for Noise and Reverberation Time;

Selectable T20 or T30 reverberation time measurement.
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Reporting:

Appendix number in header;

More space for long descriptions;

Extended configurations for flexible reporting;

Languages Italian and Czech;

Today button on calendar date.

5.5 Release V1.28
Sound Insulation in accordance with DIN 4109 including airborne noise correction at
impact noise measurement;

Laboratory measurement of sound insulation of building elements in accordance with
ISO 10140;

Measurement and analysis of impact sound insulation with rubber ball in accordance
with ISO 16283-2;

Flexible range setting for remote measurement of reverberation time;

Apply frequency response correction data for measurement microphone;

Automated test signal activation with remotely controlled PA3 Power Amplifier for
Dodecahedron Speaker DS3;

Extended reporting flexibilities, e.g. hide sending room volume.

5.6 Release V1.27
Export to Excel;

Sound Insulation in accordance with SIA 181:2006;

Low-frequency procedure in accordance with ISO 16283;

Measurement uncertainty listed as single-number results in accordance with ISO 717;

Remote measurement in the same room with one or multiple instruments;

Extended reporting flexibilities, e.g. picture added.

5.7 Release V1.26
Remote measurement in sending and receiving room at the same time;

Façade Sound Insulation in accordance with ISO 16283-3, ISO 140-5 and ASTM
E966;

Sound Insulation in accordance with GB/T 19889;

Extended reporting flexibilities.

103



5 Revision-History

5.8 Release V1.25
Remote measurement in sending and receiving room at the same time;

Façade Sound Insulation in accordance with ISO 16283-3 and ASTM E966;

Extended reporting flexibilities.
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6 End-User Licence Agreement

6 End-User Licence Agreement

This End-User License Agreement ("EULA") is a legal agreement between you (either an
individual or a single entity) and NTi Audio AG ("NTi Audio”), By installing or using the NTi
Audio software, content or documentation (collectively the “NTi Audio software") accom-
panying this EULA, you accept these terms and are consequently bound to them. If you do
not agree to the terms of this EULA, do not install or use the NTi Audio software.

The NTi Audio software is licensed not sold, to you by NTi Audio for use only under the terms
of this license agreement. This EULA only gives you some rights to use the software. You
may use the software only as expressly permitted in this EULA.

This EULA also applies for all upgrades or updates to the NTi Audio software (if any), sup-
plements, internet-based services, and support services for this NTi Audio software, unless
other term accompany those items. If so, those terms will govern.

6.1 License Uses and Restrictions
A. Software Installation: Subject to the terms and conditions of this license agreement,

you are granted a limited, non-exclusive license to use and run the NTi Audio soft-
ware. Data transfer from an NTi Audio test instrument to the NTi Audio software may
be restricted, i.e. only enabled if the corresponding license is installed on the analyzer.

B. No Reverse Engineering: You may not and you agree not to, or to enable others to,
copy (except as expressly permitted by this license agreement or by the usage rules if
they are applicable to you), publish, distribute, decompile, reverse engineer, dis-
assemble, attempt to derive the source code of, decrypt, modify, or create derivative
works of the NTi Audio software or any services provided by the NTi Audio software,
or any part thereof.

C. Termination: This license is effective until terminated. Your rights under this license
agreement will terminate automatically or otherwise cease to be effective without
notice from NTi Audio if you fail to comply with any term(s) of this license agreement.
Upon the termination of this license, you must cease all use of the NTi Audio software
and destroy all copies, full or partial, of the NTi Audio software.

6.2 Services
The NTi Audio software may enable access to NTi Audio and third-party services and web
sites (collectively and individually, “NTi Audio services”). Such NTi Audio services may not
be available in all languages or in all countries. Use of these NTi Audio services requires
internet access and use of certain NTi Audio services may requires an NTi Audio ID, may
require you to accept additional terms and may be subject to additional fees. By using this
software in connection with an NTi Audio ID or other NTi Audio account, you agree to the
applicable terms of service for that account.
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6.3 Disclaimer
A. NTi Audio and all our affiliates do not give any warranty, guarantee or conditions for

this software, i.e. you bear the sole risk of using it. This limitation applies to anything
related to this software, including breach of contract, warranty, guarantee or condition,
strict liability, negligence or other tort to the extent permitted by applicable law. It also
applies if NTi Audio knew or should have known about the possibility of the damages.

B. The NTi Audio software and services are provided “as-is”, i.e. with all faults. You bear
the sole risk of using it. NTi Audio gives no express warranties, guarantees or con-
ditions. NTi Audio excludes the implied warranties of merchantability, fitness for a par-
ticular purpose and non-infringement.

C. You acknowledge that the NTi Audio software and services are not intended or suit-
able for use in situations or environments where the failure or time delays of, or errors
or inaccuracies in the content, data or information provided by the NTi Audio software
or services could lead to death, personal injury, or severe physical or environmental
damage, including without limitation the operation of nuclear facilities, aircraft nav-
igation or communication systems, air traffic control, life support or weapons systems.

D. No oral or written information or advice given by NTi Audio or an NTi Audio authorized
representative shall create a warranty. Should the NTi Audio software or services
prove defective, you assume the entire costs of all necessary servicing, repair or cor-
rection.

E. In no event shall NTi Audio be liable for personal injury, or any incidental, special, indir-
ect or consequential damages whatsoever, including, without limitation, damages for
loss of profits, loss of data or information, business interruption or any other com-
mercial damages or losses, arising out of or related to your use or inability to use the
NTi Audio software or services or any third party software or applications in con-
junction with the NTi Audio software or services, however caused, regardless of the
theory of liability (contract, tort or otherwise) and even if NTi Audio has been advised
of the possibility of such damages. In no event shall NTi Audio’s total liability to you for
all damages exceed the amount of ten US dollars (USD 10.00). The foregoing lim-
itations will apply even if the above stated remedy fails of its essential purpose.

6.4 Separate Provisions
If any provision of this EULA shall be held to be invalid, illegal or unenforceable, the validity,
legality and enforceability of the remaining provisions shall in no way be affected or impaired
thereby.

6.5 Privacy
At all times your information will be treated in accordance with NTi Audio's privacy policy,
which is incorporated by reference into this license agreement and can be viewed at
www.nti-audio.com/privacy-statement.
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6.6 Controlling Law
This license agreement will be governed and construed in accordance with the laws of
Liechtenstein, Europe, excluding its conflict of law principles. No amendment to or modi-
fication of this EULA will be binding unless in writing and signed by NTi Audio. The English
version of this EULA shall govern, to the extent not prohibited by local law in your jurisdiction.
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APPENDIX: Sound Insulation Measurement

This application note describes how to measure sound insulation. This includes airborne and
impact sound insulation between two rooms and the airborne sound insulation of façades
using sound pressure measurements. All measurements are performed by the XL3 Acoustic
Analyzer or XL2 Acoustic Analyzer and documented using the Sound Insulation Reporter
software in accordance with the standard series ISO 16283 and ASTM.

The sound insulation is calculated by combining multiple sound pressure level and rever-
beration time measurements. The measured frequency range is typically from 50 Hz to 5
kHz. The measured airborne sound insulation is frequency-dependent but can be converted
into a single number, the sound reduction index, to characterize the acoustic performance.

This application note applies to rooms with a volume between 25 m3 and 250 m3. Special
methods apply to smaller rooms.

a. Required instrumentation
The sound level meter shall meet the requirements of a Class 1 instrument in accordance
with the IEC 61672-1 standard. The recommended configuration consists of:

XL3 Acoustic Analyzer

XL3 Acoustic Analyzer or XL3-TA for
legally traceable measurements
(=XL3 Acoustic Analyzer with Type
Approval Option installed);

Reverberation Time Option or Sound
Insulation Option (required for rever-
beration time measurement in 1/3
octave resolution;

Sound Insulation Bundle or Sound
Insulation Reporter365 (annual sub-
scription service).

XL2 Acoustic Analyzer

XL2 Acoustic Analyzer or XL2-TA for
legally traceable measurements
(=XL2 Acoustic Analyzer with Type
Approval Option installed);

Optional Extended Acoustic Pack
installed (required for reverberation
time measurement in 1/3 octave res-
olution);

XL2 Acoustic Analyzer Sound Insu-
lation Option (permanently installed)
or Sound Insulation Reporter365
(annual subscription service).

M2230 Measurement Microphone;

ASD Cable, 5m;

NTi Audio Class 1 Sound Calibrator 94 dB;

Lightweight Microphone Tripod;

DS3 Dodecahedron Speaker;

PA3 Power Amplifier;

Tapping Machine TM3;

Computer/Tablet with Sound Insulation Reporter software.
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APPENDIX: Sound Insulation Measurement

a.1 Calibration
At the beginning and at the end of each measurement day, the entire sound pressure level
measurement system shall be checked with the NTi Audio Class 1 Sound Calibrator 94 dB.
This calibrator meets the class 1 requirements specified in the standard IEC 60942.

Notes:

The sound pressure level measuring system shall be calibrated at intervals not
exceeding two years;

Wear hearing protection for all measurements.

b. Application Note: Manual Sound Insulation Measurement

c. Airborne Sound Insulation between two Rooms
Measuring the airborne sound insulation between two rooms in a building requires the fol-
lowing measurements:

Sound pressure level in the sending room;

Sound pressure level in the receiving room;

Background noise level in the receiving room;

Reverberation time in the receiving room.

The basic concept of sound insulation measurements is to play a pink noise test signal by
the Dodecahedron Speaker DS3 in the sending room. This generates a diffuse sound field in
the room. The generated sound is transmitted through the common partition into the receiv-
ing room, where also a diffuse sound field throughout the room is assumed.

First the sound pressure level spectrum is measured in the sending room at multiple micro-
phone positions and averaged. The same is repeated for the receiving room - any disturbing
background noise is deducted.

The difference indicates the insulation for the first speaker position. The same procedure is
repeated for a second speaker position. Additional reverberation time measurements are
carried out in the receiving room for corrections - e.g, the receiving room level is higher at
very reverberant rooms.

c.1 Room Selection
Airborne sound insulation is measured between two rooms. One room is chosen as the send-
ing room and the other one is chosen as the receiving room. In case the volumes of the two
rooms differ, then the smaller room shall be used as the receiving room. If one of the rooms
is box-shaped and the other has a more complicated geometry, the box-shaped room shall
be used as the receiving room.
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APPENDIX: Sound Insulation Measurement

Selecting Sending Room and Receiving Room

c.1.1 Speaker Position

Position the Dodecahedron Speaker DS3 in the sending room;

The measurements have to be carried out with at least two different speaker positions;

Choose speaker position 1 at least 0.5 m from any room boundary and at least 1.0 m
from the separating partition. Position 2 shall be similarly chosen, plus be in a different
plane relative to the room boundaries, and with a minimum 1.4 m distance to position
1. In case the separation partition is a floor and the speaker is in the upper room, then
the Dodecahedron Speaker DS3 has to be at least 1 m above the floor. The distances
are measured from the center of the individual driver unit of the Dodecahedron
Speaker DS3 closest to the boundary or other speaker position.

Positions of the test signal source for the sound level measurements

c.1.2 Test Signal Level

Reduce level settings on PA3 Power Amplifier to minimum;

Power on PA3 Power Amplifier;

Select the signal source "EQ Pink" for a flat acoustic response in the source room. Go
for "Pink" in case a higher level is required;

110



APPENDIX: Sound Insulation Measurement

Press "Signal ON" and increase the level unit it is minimum of 6 dB - better 10 dB -
higher in the receiving room than the background noise (in each frequency band from
50 Hz to 5000 Hz). In case this is not possible, then the Sound Insulation Reporter soft-
ware will automatically apply corrections in accordance with the standard.

c.2 Background Noise Level in Receiving Room
c.2.1 Preparation

It's recommended to vacate the room during the measurement so that any noise gen-
erated by the operator will not affect the measurement.

XL2 Acoustic Analyzer

Select the RTA page in the SLMeter
function on the XL2 Acoustic Ana-
lyzer;

Select 1/3 octave measurement res-
olution;

Background Noise Spectrum in the Receiving Room

XL3 Acoustic Analyzer

Select the Sound Level Meter-
function on the XL3 Acoustic Ana-
lyzer;

Select 1/3 octave measurement res-
olution;

Background Noise Spectrum in the Receiving Room

c.2.2 Measurement

Measure the background noise LZeq in the receiving room for the 15 seconds. In case
the background noise is not steady and continuous, then a longer measurement
period shall be applied e.g. 30 seconds;

Store the individual readings on the XL2 Acoustic Analyzer or XL3 Acoustic Analyzer.
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APPENDIX: Sound Insulation Measurement

Measure the Background Noise Level Lb in the Receiving Room

c.3 Sound Pressure Levels at speaker position 1
c.3.1 Preparation

Define five microphone positions in the sending and receiving room, distributed within the
maximum permitted space throughout each room. The positions shall be in a different plane
relative to the room boundaries and shall not form a regular grid. For example, mark the pos-
itions on the floor with a tape. The following minimum distance apply:

0.7 m between microphone positions;
0.5 m from any room boundary;
1.0 m between any microphone position and the speaker.

It's recommended to vacate the room during the level measurement as the operator intro-
duces additional absorption.
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APPENDIX: Sound Insulation Measurement

c.3.2 Measurements in Sending Room

XL2 Acoustic Analyzer

Measure the sound level spectrum
LZeq in the sending room at each
position for a measurement period of
at least 15 seconds;
Store the individual readings on the
XL2 Acoustic Analyzer.

Noise Spectrum in the Sending Room

XL3 Acoustic Analyzer

Measure the sound level spectrum
LZeq in the sending room at each
position for a measurement period of
at least 15 seconds;
Store the individual readings on the
XL3 Acoustic Analyzer.

Noise Spectrum in the Sending Room
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c.3.3 Measurements in Receiving Room

XL2 Acoustic Analyzer

Measure the sound level spectrum
LZeq in the receiving room at each
position for a measurement period of
at least 15 seconds;
Store the individual readings on the
XL2 Acoustic Analyzer.

Noise Spectrum in the Receiving Room

XL3 Acoustic Analyzer

Measure the sound level spectrum
LZeq in the receiving room at each
position for a measurement period of
at least 15 seconds;
Store the individual readings on the
XL3 Acoustic Analyzer.

Noise Spectrum in the Receiving Room

Measure the Sound Levels in the Sending and Receiving Room with the Speaker at Position 1

c.3.4 Sound Pressure Levels at speaker position 2

Move the Dodecahedron Speaker DS3 to source position 2.
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c.3.5 Measurements in the Sending Room

XL2 Acoustic Analyzer

Measure the sound level spectrum
LZeq in the sending room at each
position for a measurement period of
at least 15 seconds;
Store the individual readings on the
XL2 Acoustic Analyzer.

Noise Spectrum in the Sending Room

XL3 Acoustic Analyzer

Measure the sound level spectrum
LZeq in the sending room at each
position for a measurement period of
at least 15 seconds;
Store the individual readings on the
XL3 Acoustic Analyzer.

Noise Spectrum in the Sending Room
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c.3.6 Measurements in Receiving Room

XL2 Acoustic Analyzer

Measure the sound level spectrum
LZeq in the receiving room at each
position for a measurement period of
at least 15 seconds;
Store the individual readings on the
XL2 Acoustic Analyzer.

Noise Spectrum in the Receiving Room

XL3 Acoustic Analyzer

Measure the sound level spectrum
LZeq in the receiving room at each
position for a measurement period of
at least 15 seconds;
Store the individual readings on the
XL3 Acoustic Analyzer.

Noise Spectrum in the Sending Room

Measure the Sound Levels in the Sending and Receiving Room with the Speaker at Position 2
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APPENDIX: Sound Insulation Measurement

c.4 Reverberation Time in Receiving Room
c.4.1 Preparation

Move the Dodecahedron Speaker DS3 to the receiving room;
Select three microphone positions in the receiving room;

XL2 Acoustic Analyzer

Select the RT60 measurement func-
tion on theXL2 Acoustic Analyzer;
Select the 1/3 octave resolution on
the XL2 Acoustic Analyzer.

Reverberation Time T

XL3 Acoustic Analyzer

Select the Reverberation Time func-
tion on the XL3 Acoustic Analyzer;

Select the 1/3 octave resolution on
the XL3 Acoustic Analyzer.

Reverberation Time T
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c.4.2 Measurement

XL2 Acoustic Analyzer

Start the measurement on the XL2
Acoustic Analyzer;

Start / stop the test signal:

Guideline: Set the on/off cycle
time for the signal longer than
the expected reverberation time.

Measure at least two decays per pos-
ition - better three decays;

Stop the measurement on the XL2
Acoustic Analyzer;

Store the readings on the XL2 Acous-
tic Analyzer.

XL3 Acoustic Analyzer

Start the measurement on the XL3
Acoustic Analyzer;

Start / stop the test signal:

Guideline: Set the on/off cycle
time for the signal longer than
the expected reverberation time.

Measure at least two decays per pos-
ition - better three decays;

Stop the measurement on the XL3
Acoustic Analyzer;

Store the readings on the XL3 Acous-
tic Analyzer.

Measure the Reverberation Time T in the Receiving Room

c.5 Data Analysis and Reporting
Verify and document all readings by using the Sound Insulation Reporter software. This is a
PC-Software dedicated for building acoustics professionals. Load all measurement records
into the software and generate the sound insulation report. The software calculates the
weighted ratings based on the reference curve shifting method in accordance with the ISO
717-1 standard.

Calculation formulas:
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A Equivalent absorption area of the receiving room [m2]
D Level difference between the sending and receiving room [dB]
Dn Normalized level difference [dB] (the level difference D is standardized to the

equivalent absorption area of 10 m2 in the receiving room)
DnT Standardized level difference [dB] (the level difference D is standardized to

the 0.5 seconds reference value of the reverberation time in the receiving
room)

DnT,w Weighted standardized level difference (is the value of the reference curve at
500 Hz after shifting the reference curve) [dB]

L1 Sound pressure level in the sending room [dB]
L2 Sound pressure level in the receiving room [dB]
R' Apparent sound reduction index of field measurement [dB]
R’w Weighted apparent sound reduction index [dB] (is the value of the reference

curve at 500 Hz after shifting the reference curve)
S Partition area between the sending and receiving room [m2]
T Reverberation time in the receiving room [s]
V Volume of the receiving room in [m3]

d. Impact Sound Insulation
Two different source types can be used for the measurement of the impact sound insulation:

Tapping Machine:

used to assess a variety of light, hard impacts such as footsteps from walkers war-
ing hard-heeled footwear or dropped objects.

Rubber Ball:

used to assess heavy, soft impacts such as from walkers in bare feet or children
jumping, as well as quantifying absolute values that can be related to human dis-
turbance.

Here the measurement with the Tapping Machine is described.

Measuring the impact sound insulation requires the following measurements:

Background noise level in the receiving room;

Sound pressure level in the receiving room;

Reverberation time in the receiving room.

d.1 Getting Started
d.1.1 Room Selection

Typically, the impact sound insulation is measured between two rooms above each other.
The Tapping Machine is positioned in the upper room, the source room. The measurements
are performed in the lower room, the receiving room.
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d.1.2 Source Position

Position the Tapping Machine in the sending room;
The measurements have to be carried out with at least four different source positions.
The minimum distance to any wall shall be 0.5 m. In case of floor constructions with
beams the tapping machine should be placed in an angel of 45° to the direction of the
beams.

d.2 Background Noise Level in Receiving Room
d.2.1 Preparation

It's recommended to vacate the room during the measurement so that any noise gen-
erated by the operator will not affect the measurement.

XL2 Acoustic Analyzer

Select the RTA page in the SLMeter
function on the XL2 Acoustic Ana-
lyzer;
Select 1/3 octave measurement res-
olution;

Background Noise Spectrum in the Receiving Room

XL3 Acoustic Analyzer

Select the Sound Level Meter-
function on the XL3 Acoustic Ana-
lyzer;

Select 1/3 octave measurement res-
olution;

Background Noise Spectrum in the Receiving Room

d.2.2 Measurement

Measure the background noise LZeq in the receiving room for 15 seconds. In case the
background noise is not steady and continuous, then a longer measurement period
shall be applied, e.g. 30 seconds;

Store the readings on the XL2 Acoustic Analyzer or XL3 Acoustic Analyzer.
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Measure the Background Noise Level Lb in the Receiving Room - Side View

d.3 Sound Pressure Level in Receiving Room
d.3.1 Preparation

The Tapping Machine TM3 shall be placed in at least four different positions randomly dis-
tributed on the floor under test. The hammer connecting line should be at 45° to the direction
of any applicable beams or ribs in the floor. Each source position shall have a minimum dis-
tance of 0.5 m the any room boundary.

Define four microphone positions, distributed within the maximum permitted space through-
out the receiving room. Use at least two microphone positions for each source position. The
microphone positions shall be in a different plane relative to the room boundaries and shall
not form a regular grid.

For example, mark the positions on the floor with a tape. The following minimum distances
apply:

0.7 m between microphone positions;

0.5 m from any room boundary;

1.0 m from the partition being excited by the impact source.

It's recommended to vacate the room during the level measurement as the operator intro-
duces additional absorption.

d.3.2 Measurements

Measure the sound level spectrum LZeq at each microphone position for a meas-
urement period of 15 seconds;
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XL2 Acoustic Analyzer

Store the individual readings in the
XL2 Acoustic Analyzer for post cal-
culation of the sound insulation.

Noise Spectrum in the Receiving Room

XL3 Acoustic Analyzer

Store the individual readings in the
XL3 Acoustic Analyzer for post cal-
culation of the sound insulation.

Noise Spectrum in the Receiving Room

Tapping Machine Positions in Source Room - Top View
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Measure the Sound Levels in the Receiving Room with Tapping Machine at Source Position 1 - Top View

d.4 Reverberation Time in Receiving Room
d.4.1 Preparation

Move the Dodecahedron Speaker DS3 to the receiving room;
Select three microphone positions in the receiving room;

XL2 Acoustic Analyzer

Select the RT60 measurement func-
tion on the XL2 Acoustic Analyzer;
Select the 1/3 octave resolution on
the XL2 Acoustic Analyzer.

Reverberation Time T

XL3 Acoustic Analyzer

Select the Reverberation Time func-
tion on the XL3 Acoustic Analyzer;

Select the 1/3 octave resolution on
the XL3 Acoustic Analyzer.

Reverberation Time T
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d.4.2 Measurement

XL2 Acoustic Analyzer

Start the measurement on the XL2
Acoustic Analyzer;

Start / stop the signal;

Guideline: Set the on/off cycle
time for the signal longer than
the expected reverberation time.

Measure at least two decays per pos-
ition - better three decays;

Stop the measurement on the XL2
Acoustic Analyzer;

Store the readings on the XL2 Acous-
tic Analyzer.

XL3 Acoustic Analyzer

Start the measurement on the XL3
Acoustic Analyzer;

Start / stop the signal;

Guideline: Set the on/off cycle
time for the signal longer than
the expected reverberation time.

Measure at least two decays per pos-
ition - better three decays;

Stop the measurement on the XL3
Acoustic Analyzer;

Store the readings on the XL3 Acous-
tic Analyzer.

Measure the Reverberation Time T in the Receiving Room

d.5 Data Analysis and Reporting
Verify and document all readings by using the Sound Insulation Reporter software. This is a
PC-Software dedicated for building acoustics professionals. Load all measurement records
into the software and generate the sound insulation report. The software calculates the
weighted ratings based on the reference curve shifting method in accordance with the ISO
717-2 standard.

Calculation formulas:
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A Equivalent absorption area of the receiving room [m2]
Li Impact sound pressure level in the receiving room [dB]
L’n Normalized sound pressure level [dB]
Ln,w Weighted normalized sound pressure level [dB] (is the value of the reference

curve at 500 Hz after shifting the reference curve)
L’nT Standardized impact sound pressure level [dB]
L’nT,w Weighted normalized impact sound pressure level [dB] (is the value of the ref-

erence curve at 500 Hz after shifting the reference curve)
T Reverberation time in the receiving room [s]
V Volume of the receiving room in [m3]

e. Airborne Sound Insulation of Facades
Two measurement methods are distinguished for the measurement of the airborne sound
insulation of façades.

Element method:

For sound insulation measurements of façades elements, e.g. windows;

The purpose of the measurement is to obtain sound reduction index results for
comparison with laboratory.

Global method:

Provides the real sound level reduction of a façade under test in a given place rel-
ative to a position 2 m in front of the façade;

Preferred method for sound insulation measurements of whole façades including
all flanking paths;

The result cannot be compared with that of laboratory measurements.

Here the global measurement method is described.

Measuring the airborne sound insulation of façades requires the following measurments:

Background noise level in the receiving room;

Sound pressure level in front of façade;

Sound pressure level in the receiving room;

Reverberation time in the receiving room.

e.1 Getting Started
e.1.1 Speaker Position

Position the Dodecahedron Speaker DS3 outdoors in front of the façade. The distance
D shall be at least 5 m;
The angle of sound incidence at the facade shall be 45° +/- 5°. The distance from the
loudspeaker to the center of the facade under test shall be at least 7 m;
The sending sound pressure level is measured 2 m in front of the façade;
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The measurements may be carried out at one or multiple speakers positions. Several
speaker positions are required at very large rooms or in case the room has two or
more outside walls.

e.1.2 Test Signal Level

Start the pink noise test signal at a low level;
Increase the level until it is minimum of 6 dB— better 10 dB - higher in the receiving
room than the background noise (in each frequency band from 0 Hz to 5000 Hz). In
case this is not possible, then the Sound Insulation Reporter software will auto-
matically apply corrections in accordance with the standard.

e.2 Background Noise Level in Receiving Room
e.2.1 Preparation

It's recommended to vacate the room during the measurement so that any noise gen-
erated by the operator will not affect the measurement.
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XL2 Acoustic Analyzer

Select the RTA page in the SLMeter
function on the XL2 Acoustic Ana-
lyzer;
Select 1/3 octave measurement res-
olution;

Background Noise Spectrum in the Receiving Room

XL3 Acoustic Analyzer

Select the Sound Level Meter-
function on the XL3 Acoustic Ana-
lyzer;

Select 1/3 octave measurement res-
olution;

Background Noise Spectrum in the Receiving Room

e.2.2 Measurement

Measure the background noise LZeq in the receiving room for 15 seconds. In case the
background noise is not steady and continuous, then a longer measurement period
shall be applied, e.g. 30 seconds;

Store the readings on the XL2 Acoustic Analyzer or XL3 Acoustic Analyzer.
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Measure the Background Noise Level Lb in the Receiving Room - Top View

e.3 Outdoor Sound Pressure Level in front of Facade
e.3.1 Preparation

The sending sound pressure level is measured outdoor at 2 m (+/- 0.2m) in front of the
facade surface center under test. The height of the microphone is 1.5 m above the receiving
room floor.

e.3.2 Measurements

Measure the sending sound level spectrum LZeq for a measurement period of at least
15 seconds;
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XL2 Acoustic Analyzer

Store the readings on the XL2 Acous-
tic Analyzer.

Noise Spectrum in front of Facade

XL3 Acoustic Analyzer

Store the readings on the XL3 Acous-
tic Analyzer.

Noise Spectrum in front of the Facade

Measure the Sound Level in the Outdoor Sending Area - Side View

e.4 Sound Pressure Level in Receiving Room
e.4.1 Preparation

Define five microphone positions in the sending and receiving room, distributed within the
maximum permitted space throughout each room. The positions shall be in a different plane
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relative to the room boundaries and shall not form a regular grid. For example, mark the pos-
itions on the floor with a tape. The following minimum distances apply:

0.7 m between microphone positions;
0.5 m from any room boundary;
1.0 m between any microphone position and the speaker.

It's recommended to vacate the room during the level measurement as the operator intro-
duces additional absorption.

e.4.2 Measurements

Measure the sending and receiving sound level spectrum LZeq at each microphone
position for a measurement period of at least 15 seconds;

XL2 Acoustic Analyzer

Store the readings on the XL2 Acous-
tic Analyzer.

Noise Spectrum in the Receiving Room

XL3 Acoustic Analyzer

Store the readings on the XL2 Acous-
tic Analyzer.

Noise Spectrum in the Receiving Room
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Measure the Sound Levels in the Receiving Room - Top View

e.5 Reverberation Time in Receiving Room
e.5.1 Preparation

Move the Dodecahedron Speaker DS3 to the receiving room;
Select three microphone positions in the receiving room;

XL2 Acoustic Analyzer

Select the RT60 measurement func-
tion on the XL2 Acoustic Analyzer;
Select the 1/3 octave resolution on
the XL2 Acoustic Analyzer.

Reverberation Time T

XL3 Acoustic Analyzer

Select the Reverberation Time func-
tion on the XL3 Acoustic Analyzer;
Select the 1/3 octave resolution on
the XL3 Acoustic Analyzer.

Reverberation Time T
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e.5.2 Measurement

XL2 Acoustic Analyzer

Start the measurement on the XL2
Acoustic Analyzer;

Start / stop the signal:

Guideline: Set the on/off cycle
time for the signal longer than
the expected reverberation time.

Measure at least two decays per pos-
ition - better three decays;

Stop the measurement on the XL2
Acoustic Analyzer;

Store the readings on the XL2 Acous-
tic Analyzer.

XL3 Acoustic Analyzer

Start the measurement on the XL3
Acoustic Analyzer;

Start / stop the signal:

Guideline: Set the on/off cycle
time for the signal longer than
the expected reverberation time.

Measure at least two decays per pos-
ition - better three decays;

Stop the measurement on the XL3
Acoustic Analyzer;

Store the readings on the XL3 Acous-
tic Analyzer.

Measure the Reverberation Time T - Top View

e.6 Data Analysis and Reporting
Verify and document all readings by using the Sound Insulation Reporter software. This is a
PC-Software dedicated for building acoustics professionals. Load all measurement records
into the software and generate the sound insulation report. The software calculates the
weighted ratings based on the reference curve shifting method in accordance with the ISO
717-1 standard.

Calculation formas:
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A Equivalent absorption area of the receiving room [m2]
D Difference between facade level and receiving room level using element

method [dB]
D2m Difference between level 2 m in front of facade and receiving room level [dB]
D2m,n Normalized level difference [dB] (the level difference D is standardized to the

equivalent absorption area of 10 m2 in the receiving room)
D2m,nT Standardized level difference [dB] (the level difference D is standardized to

the 0.5 seconds reference value of the reverberation time in the receiving
room)

DnT,w Weighted standardized level difference (is the value of the reference curve at
500 Hz after shifting the reference curve) [dB]

L1,2m Sound pressure level measured 2 m in front of facade [dB]
L2 Sound pressure level in the receiving room [dB]
R’45° Apparent sound reduction index of field measurement using element method

[dB]
R’45°,w Weighted apparent sound reduction index using element method [dB] (is the

value of the reference curve at 500 Hz after shifting the reference curve)
S Partition area between the sending and receiving roomm2
T Reverberation time in the receiving room [s]
V Volume of the receiving room in [m3]

f. Application Note: Sound Insulation Measurement with XL3
Acoustic Analyzer Sound Insulation Option

g. Airborne Sound Insulation between two Rooms
Measuring the airborne sound insulation between two rooms in a building requires the fol-
lowing measurements:

Sound pressure level in the sending room;

Sound pressure level in the receiving room;

Background noise level in the receiving room;

Reverberation time in the receiving room.

The basic concept of sound insulation measurements is to play a pink noise test signal by
the Dodecahedron Speaker DS3 in the sending room. This generates a diffuse sound field in
the room. The generated sound is transmitted through the common partition into the receiv-
ing room, where also a diffuse sound field throughout the room is assumed.
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First the sound pressure level spectrum is measured in the sending room at multiple micro-
phone positions and averaged. The same is repeated for the receiving room - any disturbing
background noise is deducted.

The difference indicates the insulation for the first speaker position. The same procedure is
repeated for a second speaker position. Additional reverberation time measurements are
carried out in the receiving room for corrections - e.g, the receiving room level is higher at
very reverberant rooms.

g.1 Room Selection
Airborne sound insulation is measured between two rooms. One room is chosen as the send-
ing room and the other one is chosen as the receiving room. In case the volumes of the two
rooms differ, then the smaller room shall be used as the receiving room. If one of the rooms
is box-shaped and the other has a more complicated geometry, the box-shaped room shall
be used as the receiving room.

Selecting Sending Room and Receiving Room

g.1.1 Speaker Position

Position the Dodecahedron Speaker DS3 in the sending room;

The measurements have to be carried out with at least two different speaker positions;

Choose speaker position 1 at least 0.5 m from any room boundary and at least 1.0 m
from the separating partition. Position 2 shall be similarly chosen, plus be in a different
plane relative to the room boundaries, and with a minimum 1.4 m distance to position
1. In case the separation partition is a floor and the speaker is in the upper room, then
the Dodecahedron Speaker DS3 has to be at least 1 m above the floor. The distances
are measured from the center of the individual driver unit of the Dodecahedron
Speaker DS3 closest to the boundary or other speaker position.
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Positions of the test signal source for the sound level measurements

g.1.2 Test Signal Level

Reduce level settings on PA3 Power Amplifier to minimum;

Power on PA3 Power Amplifier;

Select the signal source "EQ Pink" for a flat acoustic response in the source room. Go
for "Pink" in case a higher level is required;

Press "Signal ON" and increase the level unit it is minimum of 6 dB - better 10 dB -
higher in the receiving room than the background noise (in each frequency band from
50 Hz to 5000 Hz). In case this is not possible, then the Sound Insulation Reporter soft-
ware will automatically apply corrections in accordance with the standard.

g.2 Background Noise Level in Receiving Room
g.2.1 Preparation

It's recommended to vacate the room during the measurement so that any noise gen-
erated by the operator will not affect the measurement.

To measure the background sound level in
the receiving room, select on the XL3
Acoustic Analyzer "Select measurement"
page and press the button.

Background Noise Spectrum in the Receiving Room
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g.2.2 Measurement

Measure the background noise LZeq in the receiving room for the 15 seconds. In case
the background noise is not steady and continuous, then a longer measurement
period shall be applied e.g. 30 seconds;

Store the individual readings on the XL3 Acoustic Analyzer.

Measure the Background Noise Level Lb in the Receiving Room

g.3 Sound Pressure Levels at speaker position 1
g.3.1 Preparation

Define five microphone positions in the sending and receiving room, distributed within the
maximum permitted space throughout each room. The positions shall be in a different plane
relative to the room boundaries and shall not form a regular grid. For example, mark the pos-
itions on the floor with a tape. The following minimum distance apply:

0.7 m between microphone positions;
0.5 m from any room boundary;
1.0 m between any microphone position and the speaker.

It's recommended to vacate the room during the level measurement as the operator intro-
duces additional absorption.
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g.4 Measurements in Sending Room

Press the key to initiate the meas-
urement and wait until it is completed. Once
you have taken enough individual meas-
urements for , press the key on
theXL3 Acoustic Analyzer.

Noise Spectrum in the Sending Room

g.4.1 Measurements in Receiving Room

Proceed to the L2 receiving room and
choose located on the "Select
measurement" page. Activate the
sound source (which is still placed at
position #1 in the transmitting room)
and press the button to initiate
the initial sound level measurement
in the receiving room.
Proceed with conducting the remain-
ing measurements in the receiving
room for the data set and then
press the button.

Select on the "Select meas-
urement" page and position the
noise source in the transmitter room
at position #2.
Repeat the aforementioned meas-
urements in both the transmit and
receive rooms for noise source pos-
ition #2. Repeat this process until all
L1-x and L2-x measurements for dif-
ferent noise source positions in the
transmitter room are completed.

Noise Spectrum in the Receiving Room
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Measure the Sound Levels in the Sending and Receiving Room with the Speaker at Position 1

g.4.2 Sound Pressure Levels at speaker position 2

Move the Dodecahedron Speaker DS3 to source position 2.

g.4.3 Measurements in the Sending Room

Press the key to initiate the first
measurement and wait until it is com-
pleted. Move to the next meas-
urement position and press the
key again to start the second (or third,
etc.) sound level measurement in the
receiving room. Once you have taken
enough individual measurements for

, press the key on theXL3
Acoustic Analyzer.

Noise Spectrum in the Sending Room

138



APPENDIX: Sound Insulation Measurement

g.4.4 Measurements in Receiving Room

Select on the "Select meas-
urement" page and position the
noise source in the transmitter room
at position #2.
Repeat the aforementioned meas-
urements in both the transmit and
receive rooms for noise source pos-
ition #2. Repeat this process until all
L1-x and L2-x measurements for dif-
ferent noise source positions in the
transmitter room are completed.

Noise Spectrum in the Receiving Room

Measure the Sound Levels in the Sending and Receiving Room with the Speaker at Position 2

g.5 Reverberation Time in Receiving Room
g.5.1 Preparation

Move the Dodecahedron Speaker DS3 to the receiving room;
Select three microphone positions in the receiving room;
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Choose on theXL3 Acoustic
Analyzer "Select measurement"
page.

Press the button to commence
the reverberation time measurement
and toggle the speaker On and Off
multiple times. Then press the
button.

Reverberation Time T

g.5.2 Measurement

Conclude the measurement series by first pressing the button and then tapping

. You can now review the measurement results D, Dn, DnT, or R' individually by
pressing the corresponding button under "Results".

Measure the Reverberation Time T in the Receiving Room

g.6 Data Analysis and Reporting
Verify and document all readings by using the Sound Insulation Reporter software. This is a
PC-Software dedicated for building acoustics professionals. Load all measurement records
into the software and generate the sound insulation report. The software calculates the
weighted ratings based on the reference curve shifting method in accordance with the ISO
717-1 standard.

Calculation formulas:
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A Equivalent absorption area of the receiving room [m2]
D Level difference between the sending and receiving room [dB]
Dn Normalized level difference [dB] (the level difference D is standardized to the

equivalent absorption area of 10 m2 in the receiving room)
DnT Standardized level difference [dB] (the level difference D is standardized to

the 0.5 seconds reference value of the reverberation time in the receiving
room)

DnT,w Weighted standardized level difference (is the value of the reference curve at
500 Hz after shifting the reference curve) [dB]

L1 Sound pressure level in the sending room [dB]
L2 Sound pressure level in the receiving room [dB]
R' Apparent sound reduction index of field measurement [dB]
R’w Weighted apparent sound reduction index [dB] (is the value of the reference

curve at 500 Hz after shifting the reference curve)
S Partition area between the sending and receiving room [m2]
T Reverberation time in the receiving room [s]
V Volume of the receiving room in [m3]

h. Impact Sound Insulation
Two different source types can be used for the measurement of the impact sound insulation:

Tapping Machine:

used to assess a variety of light, hard impacts such as footsteps from walkers war-
ing hard-heeled footwear or dropped objects.

Rubber Ball:

used to assess heavy, soft impacts such as from walkers in bare feet or children
jumping, as well as quantifying absolute values that can be related to human dis-
turbance.

Here the measurement with the Tapping Machine is described.

Measuring the impact sound insulation requires the following measurements:

Background noise level in the receiving room;

Sound pressure level in the receiving room;

Reverberation time in the receiving room.
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h.1 Getting Started
h.1.1 Room Selection

Typically, the impact sound insulation is measured between two rooms above each other.
The Tapping Machine is positioned in the upper room, the source room. The measurements
are performed in the lower room, the receiving room.

h.1.2 Source Position

Position the Tapping Machine in the sending room;
The measurements have to be carried out with at least four different source positions.
The minimum distance to any wall shall be 0.5 m. In case of floor constructions with
beams the tapping machine should be placed in an angel of 45° to the direction of the
beams.

h.2 Background Noise Level in Receiving Room
h.2.1 Preparation

It's recommended to vacate the room during the measurement so that any noise gen-
erated by the operator will not affect the measurement.

To measure the background sound level in
the receiving room, select on the XL3
Acoustic Analyzer "Select measurement"
page and press the button.

Background Noise Spectrum in the Receiving Room

h.2.2 Measurement

Measure the background noise LZeq in the receiving room for 15 seconds. In case the
background noise is not steady and continuous, then a longer measurement period
shall be applied, e.g. 30 seconds;

Store the readings on the XL3 Acoustic Analyzer.

142



APPENDIX: Sound Insulation Measurement

Measure the Background Noise Level Lb in the Receiving Room - Side View

h.3 Sound Pressure Level in Receiving Room
h.3.1 Preparation

The Tapping Machine TM3 shall be placed in at least four different positions randomly dis-
tributed on the floor under test. The hammer connecting line should be at 45° to the direction
of any applicable beams or ribs in the floor. Each source position shall have a minimum dis-
tance of 0.5 m the any room boundary.

Define four microphone positions, distributed within the maximum permitted space through-
out the receiving room. Use at least two microphone positions for each source position. The
microphone positions shall be in a different plane relative to the room boundaries and shall
not form a regular grid.

For example, mark the positions on the floor with a tape. The following minimum distances
apply:

0.7 m between microphone positions;

0.5 m from any room boundary;

1.0 m from the partition being excited by the impact source.

It's recommended to vacate the room during the level measurement as the operator intro-
duces additional absorption.

h.3.2 Measurements

Measure the sound level spectrum LZeq at each microphone position for a meas-
urement period of 15 seconds;
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Proceed to the L2 receiving room and
choose located on the "Select
measurement" page. Activate the
sound source (which is still placed at
position #1 in the transmitting room)
and press the button to initiate
the initial sound level measurement
in the receiving room.
Proceed with conducting the remain-
ing measurements in the receiving
room for the data set and then
press the button.

Select on the "Select meas-
urement" page and position the
noise source in the transmitter room
at position #2.
Repeat the aforementioned meas-
urements in both the transmit and
receive rooms for noise source pos-
ition #2. Repeat this process until all
L1-x and L2-x measurements for dif-
ferent noise source positions in the
transmitter room are completed.

Noise Spectrum in the Receiving Room

Tapping Machine Positions in Source Room - Top View
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Measure the Sound Levels in the Receiving Room with Tapping Machine at Source Position 1 - Top View

h.4 Reverberation Time in Receiving Room
h.4.1 Preparation

Move the Dodecahedron Speaker DS3 to the receiving room;
Select three microphone positions in the receiving room;

Choose on theXL3 Acoustic
Analyzer "Select measurement"
page.

Press the button to commence
the reverberation time measurement
and toggle the speaker On and Off
multiple times. Then press the
button.

Reverberation Time T

h.4.2 Measurement

Conclude the measurement series by first pressing the button and then tapping

. You can now review the measurement results L’n and L’nT individually by pressing
the corresponding button under "Results".
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Measure the Reverberation Time T in the Receiving Room

h.5 Data Analysis and Reporting
Verify and document all readings by using the Sound Insulation Reporter software. This is a
PC-Software dedicated for building acoustics professionals. Load all measurement records
into the software and generate the sound insulation report. The software calculates the
weighted ratings based on the reference curve shifting method in accordance with the ISO
717-2 standard.

Calculation formulas:

A Equivalent absorption area of the receiving room [m2]
Li Impact sound pressure level in the receiving room [dB]
L’n Normalized sound pressure level [dB]
Ln,w Weighted normalized sound pressure level [dB] (is the value of the reference

curve at 500 Hz after shifting the reference curve)
L’nT Standardized impact sound pressure level [dB]
L’nT,w Weighted normalized impact sound pressure level [dB] (is the value of the ref-

erence curve at 500 Hz after shifting the reference curve)
T Reverberation time in the receiving room [s]
V Volume of the receiving room in [m3]

i. Airborne Sound Insulation of Facades
Two measurement methods are distinguished for the measurement of the airborne sound
insulation of façades.
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Element method:

For sound insulation measurements of façades elements, e.g. windows;

The purpose of the measurement is to obtain sound reduction index results for
comparison with laboratory.

Global method:

Provides the real sound level reduction of a façade under test in a given place rel-
ative to a position 2 m in front of the façade;

Preferred method for sound insulation measurements of whole façades including
all flanking paths;

The result cannot be compared with that of laboratory measurements.

Here the global measurement method is described.

Measuring the airborne sound insulation of façades requires the following measurments:

Background noise level in the receiving room;

Sound pressure level in front of façade;

Sound pressure level in the receiving room;

Reverberation time in the receiving room.

i.1 Getting Started
i.1.1 Speaker Position

Position the Dodecahedron Speaker DS3 outdoors in front of the façade. The distance
D shall be at least 5 m;
The angle of sound incidence at the facade shall be 45° +/- 5°. The distance from the
loudspeaker to the center of the facade under test shall be at least 7 m;
The sending sound pressure level is measured 2 m in front of the façade;
The measurements may be carried out at one or multiple speakers positions. Several
speaker positions are required at very large rooms or in case the room has two or
more outside walls.
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i.1.2 Test Signal Level

Start the pink noise test signal at a low level;
Increase the level until it is minimum of 6 dB— better 10 dB - higher in the receiving
room than the background noise (in each frequency band from 0 Hz to 5000 Hz). In
case this is not possible, then the Sound Insulation Reporter software will auto-
matically apply corrections in accordance with the standard.

i.2 Background Noise Level in Receiving Room
i.2.1 Preparation

It's recommended to vacate the room during the measurement so that any noise gen-
erated by the operator will not affect the measurement.

To measure the background sound level in
the receiving room, select on the XL3
Acoustic Analyzer "Select measurement"
page and press the button.

Background Noise Spectrum in the Receiving Room
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i.2.2 Measurement

Measure the background noise LZeq in the receiving room for 15 seconds. In case the
background noise is not steady and continuous, then a longer measurement period
shall be applied, e.g. 30 seconds;

Store the readings on the XL3 Acoustic Analyzer.

Measure the Background Noise Level Lb in the Receiving Room - Top View

i.3 Outdoor Sound Pressure Level in front of Facade
i.3.1 Preparation

The sending sound pressure level is measured outdoor at 2 m (+/- 0.2m) in front of the
facade surface center under test. The height of the microphone is 1.5 m above the receiving
room floor.

i.3.2 Measurements

Measure the sending sound level spectrum LZeq for a measurement period of 15
seconds;
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Press the key to initiate the meas-
urement and wait until it is completed. Once
you have taken enough individual meas-
urements for , press the key on
theXL3 Acoustic Analyzer.

Noise Spectrum in front of Facade

Measure the Sound Level in the Outdoor Sending Area - Side View

i.4 Sound Pressure Level in Receiving Room
i.4.1 Preparation

Define five microphone positions in the sending and receiving room, distributed within the
maximum permitted space throughout each room. The positions shall be in a different plane
relative to the room boundaries and shall not form a regular grid. For example, mark the pos-
itions on the floor with a tape. The following minimum distances apply:

0.7 m between microphone positions;
0.5 m from any room boundary;
1.0 m between any microphone position and the speaker.
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It's recommended to vacate the room during the level measurement as the operator intro-
duces additional absorption.

i.4.2 Measurements

Measure the sending and receiving sound level spectrum LZeq at each microphone
position for a measurement period of 15 seconds;

Proceed to the L2 receiving room and
choose located on the "Select meas-
urement" page. Activate the sound source
(which is still placed at position #1 in front of
Facade) and press the button to ini-
tiate the initial sound level measurement in
the receiving room.
Proceed with conducting the remaining
measurements in the receiving room for the
data set and then press the but-
ton.
Select on the "Select measurement"
page and position the noise source in front
of the Facade at position #2.
Repeat the aforementioned measurements
in both, in front of the Facade and Receive
rooms for noise source position #2. Repeat
this process until all L1-x and L2-x meas-
urements for different noise source pos-
itions in the transmitter room are
completed.

Noise Spectrum in the Receiving Room

Measure the Sound Levels in the Receiving Room - Top View
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i.5 Reverberation Time in Receiving Room
i.5.1 Preparation

Move the Dodecahedron Speaker DS3 to the receiving room;
Select three microphone positions in the receiving room;

Choose on theXL3 Acoustic
Analyzer "Select measurement"
page.

Press the button to commence
the reverberation time measurement
and toggle the speaker On and Off
multiple times. Then press the
button.

Reverberation Time T

i.5.2 Measurement

Conclude the measurement series by first pressing the button and then tapping

. You can now review the measurement results D or R’45° individually by pressing
the corresponding button under "Results".

Measure the Reverberation Time T - Top View
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i.6 Data Analysis and Reporting
Verify and document all readings by using the Sound Insulation Reporter software. This is a
PC-Software dedicated for building acoustics professionals. Load all measurement records
into the software and generate the sound insulation report. The software calculates the
weighted ratings based on the reference curve shifting method in accordance with the ISO
717-1 standard.

Calculation formas:

A Equivalent absorption area of the receiving room [m2]
D Difference between facade level and receiving room level using element

method [dB]
D2m Difference between level 2 m in front of facade and receiving room level [dB]
D2m,n Normalized level difference [dB] (the level difference D is standardized to the

equivalent absorption area of 10 m2 in the receiving room)
D2m,nT Standardized level difference [dB] (the level difference D is standardized to

the 0.5 seconds reference value of the reverberation time in the receiving
room)

DnT,w Weighted standardized level difference (is the value of the reference curve at
500 Hz after shifting the reference curve) [dB]

L1,2m Sound pressure level measured 2 m in front of facade [dB]
L2 Sound pressure level in the receiving room [dB]
R’45° Apparent sound reduction index of field measurement using element method

[dB]
R’45°,w Weighted apparent sound reduction index using element method [dB] (is the

value of the reference curve at 500 Hz after shifting the reference curve)
S Partition area between the sending and receiving roomm2
T Reverberation time in the receiving room [s]
V Volume of the receiving room in [m3]

j. Know How
j.1 Diffuse Sound Field
One of the assumptions commonly made in sound insulation measurements is that the
sound field in a room can be considered as being diffuse (= the sound energy density is uni-
form throughout the space). This is not strictly correct because diffuse sound fields don’t
occur in real box-shaped rooms with stationary surfaces and absorbent boundaries.
However, in the field situation there are some rooms in which there are close approximations
to a diffuse sound field in the mid and high frequency ranges. In frequency bands lower than
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about 400 Hz in general and especially lower than 100 Hz, no diffuse-field conditions in the
test room can be expected especially when room volumes of 50 m3 or less are considered.

The preceding described measurement procedure allows for measurements to be taken
without any knowledge as to whether the sound field can be considered as diffuse or non-dif-
fuse.

j.2 Source Position
For airborne sound insulation measurements in non-diffuse sound fields it is necessary to
excite the majority of the modes in the source room. For this reason, loudspeaker positions
near the corners are used in boxshaped rooms as well as other shapes of room. Many more
modes are excited by the source in a corner position than a central point. In addition, it is
necessary to take average measurement from more than one source position. (Sound Insu-
lation by Carl Hopkins, 2007, Elsevier & Revision of international standards by Carl Hopkins,
2015, Elsevier).

j.3 Sound Reduction Index R
The sound insulation capabilities of a particular wall, ceiling, or component can be measured
in a laboratory, and a sound reduction index R assigned to it. For such laboratory meas-
urements it's important that the sound transmitted from the sending room into the receiving
room not directly through the partition under test (e.g. via the side walls) is at least 15 dB
below the sound transmitted directly through the partition.

Default room layout

j.4 Apparent Sound Reduction R'
In an actual building (outside of the laboratory), sound may find a way around the main
room-separating partition e.g, through a window or an electric wiring channel; the sound
level in the receiving room is not just the sound transmitted through the partition itself. There-
fore, the so-called Apparent Sound Reduction Index R’ is measured.

j.5 Normalized level difference Dn
The normalized level difference Dn is used for situations where there is no common partition
area or where the partition area is not easily determined (e.g. fan opening, ventilation, etc.).
The sound pressure level is measured in the sending and receiving room and the difference
D calculated. As the level in the receiving room depends on the absorption within the room,
the level difference is normalized with the actual absorption area in the receiving room in rela-
tion to a reference absorption area of 10 m2. In relation to the sound insulation index R, a nor-
malized level difference Dn of, for example, 40 dB can be seen as a wall area of 10 m2 with
R = 40 dB.
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Room layout without common partition area

j.6 Standardized level difference DnT
The standardized level difference describes the sound insulation between two rooms. This
term is commonly specified in local standards with minimum requirements. The sound pres-
sure level is measured in the sending and receiving room and the difference D calculated. As
the level in the receiving room depends on the reverberation time T in the room, the level dif-
ference is standardized to the measured reverberation time in the receiving room in relation
to a reference reverberation time of 0.5 seconds.

j.7 Related Standards

ISO 16283-1 Acoustics — Field measurement of sound insulation in buildings end of
building elements — Part 1: Airborne sound insulation

ISO 16283-2 Acoustics — Field measurement of sound insulation in buildings and of
building elements — Part 2: Impact sound insulation

ISO 16283-3 Acoustics — Field measurement of sound insulation in buildings and of
building elements — Part 3: Facade sound insulation

ISO 717-1 Acoustics — Rating of sound insulation in buildings and of building ele-
ments — Part 1: Airborne sound insulation

ISO 717-2 Acoustics — Rating of sound insulation in buildings and of building ele-
ments — Part 2: Impact sound insulation

IEC 61672-1 Electroacoustics — Sound level meters — Part 1: Specifications

IEC 61260-1 Electroacoustics —Octave-band and fractional-octave-band filters —
Part 1 Specifications

IEC 60942 Electroacoustics - Sound calibrators

ISO 3382-2 Acoustics —Measurement of room acoustic parameters — Part 2:
Reverberation time in ordinary rooms
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k. Sound Insulation according ASTM
k.1 Airborne Sound Insulation
ASTM specifies the measurement of airborne sound insulation between two rooms in the
standards E336 and E413. Calculation formulas:

ATL Apparent transmission loss [dB]

ASTC
Apparent sound transmission class [dB] (single number rating obtained by
applying the classification procedure of Classification E413 to apparent trans-
mission loss data)

A Sound absorption in the receiving room [m2]
c Speed of sound [m/s]
L1 Sound pressure level in the sending room [dB]
L2 Sound pressure level in the receiving room [dB]
NR Noise reduction between the sending and receiving room [dB]

NIC Noise isolation class [dB] (a single-number rating calculated in accordance
with Classification E413 using measured values of noise reduction)

NNR Normalized noise reduction [dB] (the level difference D is standardized to the
0.5 seconds reference value of the reverberation time in the receiving room)

NNIC
Normalized noise isolation class [dB] (a single-number rating calculated in
accordance with Classification E413 using measured values ofnormalized
noise reduction)

S Partition area between the sending and receiving room [m2]
t Room temperature [°C]
T Reverberation time in the receiving room [s]
V Volume of the receiving room in [m3]

k.2 Impact Sound Insulation
ASTM specifies the measurement of impact sound insulation in the standards E1007 and
E989. Calculation formulas:
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A Sound absorption in the receiving room [m2]

AIIC
Apparent impact insulation class [dB] (a single-number rating derived from
values of ANISPL in accordance with Classification E989,formerly FIIC for
field impact insulation class)

ANISPL Absorption normalized impact sound pressure level [dB]
c Speed of sound [m/s]

ISPL Impact sound pressure level produced in the receiving room by the operation
of the standard tapping machine on a floor-ceiling assembly[dB]

ISR Impact sound rating [dB] (a single-number rating derived from values of ISPL
in accordance with Classification E989)

NISR Normalized impact sound rating [dB] (a single-number rating derived from
values of RTNISPL in accordance with Classification E989)

RTNISPL Reverberation time normalized impact sound pressure level [dB]
t Room temperature [°C]
T Reverberation time in the receiving room [s]
V Volume of the receiving room in [m3]

k.3 Facade Sound Insulation
ASTM specifies the measurement of facade sound insulation in the standards E966 and
E1332. Calculation formulas:

A Sound absorption in the receiving room [m2]

AOITC
Apparent outdoor-indoor transmission class [dB] (a single-number rating cal-
culated in accordance with Classification E1332 using measured values of
apparent outdoor-indoor transmission loss)

AOITL Apparent outdoor-indoor transmission loss [dB]
c Speed of sound [m/s]

L2m Nearby microphone method - sound pressure level measured 2 m in front of
facade [dB]

Lflush Flush microphone method - sound pressure level measured very close to the
facade [dB]

Lfree
Calibrated source method - sound pressure level of the source calibrated in
free-field environment at the same distance that the source is to be facade
dB]

Lin Sound pressure level in the receiving room [dB]

OINIC
Outdoor-indoor noise isolation class [dB] (a single-number rating calculated
in accordance with Classification E1332 using values of outdoor-indoor
noise reduction)

157



APPENDIX: Sound Insulation Measurement

OINR Outdoor-indoor noise reduction [dB]
S Partition area between the outdoor area and receiving room [m2]
t Room temperature [°C]
T Reverberation time in the receiving room [s]
Θ Angle of incidence of test sound [°]
V Volume of the receiving room in [m3]

k.4 Related Standards

ASTM E336 Standard Test Method for Measurement of Airborne Sound Attenuation
between Rooms in Buildings

ASTM E413 Classification for Rating Sound Insulation

ASTM E1007
Standard Test Method for Field Measurement of Tapping Machine
Impact Sound Transmission Through Floor-Ceiling Assemblies and
Associated Support Structures

ASTM E989 Standard Classification for Determination of Single-Number Metrics for
Impact Noise

ASTM E966 Standard Guide for Field Measurements of Airborne Sound Attenuation
of Building Facades and Facade Elements

ASTM E1332 Standard Classification for Rating Outdoor-Indoor Sound Attenuation

ANSI/ASA S1.4
/ Part 1

American National Standard Electroacoustics - Sound Level Meters -
Part Specifications (a nationally adopted international standard IEC
61672-1)

ANSI/ASA
S1.11 / Part 1

Electroacoustics - Octave-band and Fractional-octave-band Filters -Part
2: Pattern-evaluation Tests (a nationally adopted international standard
IEC 61260-1)

ANSI/ASA
S1.40

American National Standard Specifications and Verification Procedures
for Sound Calibrators

IEC 60942 Electroacoustics - Sound calibrators

ASTM E2235 Standard Test Method for Determination of Decay Rates for Use in
Sound Insulation Test Methods
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